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About This Manual

The Macintosh Application Environment (MAE) is software that, with a few
extra features to adapt it for use on a UNIX® system, runs a virtual Macintosh
environment within the X Window System™ on your workstation. MAE
displays the Macintosh desktop interface in an X window. The Macintosh
desktop within the MAE window gives you access to your Macintosh
applications as well as to UNIX files.

This book explains how to install and set up MAE and how to install
Macintosh applications in your Macintosh environment. It also explains how
to perform Macintosh tasks in MAE, how to manage UNIX files on the MAE
desktop, and how to customize MAE. This manual discusses only features and
tasks that you perform in order to work with MAE. It does not explain the
basics of how to work in the UNIX (or X Window System) environment on a
workstation.
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What you need to know

This book assumes that you are familiar with UNIX and with the X Window
System. You should know how to perform basic tasks on your workstation,
including starting and quitting X applications.

For general information about the X Window System, you may want to read
X Window System User’s Guide (Valerie Quercia and Tim O’Reilly, O’Reilly
and Associates, 1990).

This book also assumes that you are familiar with the Macintosh user
interface, including the use of icons, windows, and folders. For a summary of
Macintosh basics, see Appendix A. For complete information on the use of the
Macintosh, see Macintosh User’s Guide (part number 030-2651-B).
Macintosh User’s Guide is not included with MAE.

New features in MAE version 3.0

MAE version 3.0 contains the following new features:

m Improved performance—enhanced emulator speeds up all applications.

m System 7.5.3 support—provides the benefits of this version of the
Mac OS.

m An enhanced installer—provides several options to improve the
installation process when it is run from the command line and an option to
have the system reboot automatically after kernel modules are installed.

m Foating licenses—simplifies the use of MAE in a networked environment
and allows users to share licensed copies of MAE more efficiently using
FLEXlm technology.

m Multiple independent volume support—allows UNIX directories to be
mounted and used as if they were Macintosh volumes.

m Additional CD-ROM formats—allows the use of CD-ROM discs in the
standard ISO 9660 format as well as the single-session Photo CD format.

m Multiple LAN interface support—allows you to have multiple local area
network (LAN) interface cards in your workstation and to specify which
one MAE will use for MacTCP services.

m An improved Find File utility—improves the performance of the Find
File utility and allows you to differentiate between AppleShare and NFS
servers in your searches.

m Improved performance for remote X display servers—improves the
performance of MAE when it is displayed on a remote X server.

m X Window scaling—allows you to easily magnify your MAE window to
two times the standard size for easier viewing.
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m Smaller system folders—reduces the disk space required by additional
System Folders on a single workstation.

m Improved Software FPU utility—significantly increases the speed of
floating-point operations.

m A greater number of simultaneously open files—allows up to 1024 files
to be open at the same time.

m Improved keyboard support—provides easy-to-recognize keyboard maps
and automatically determines which one to use.

m Improved file-sharing security—increases the administrator’s options for
restricting the user’s ability to share files and folders.

Terminology used in this manual

This section explains the terminology used in this manual to refer to certain
keys and to basic mouse and keyboard operations within MAE.

Modifier keys

This book refers often to several modifier keys that appear on standard Apple
keyboards: Command (x), Option, Control, and Caps Lock. Since your
workstation keyboard may not have these keys, MAE assigns them to keys on
your workstation keyboard. When this manual tells you to use one of these
keys, use instead the key on your keyboard to which it has been assigned.

MAE also assigns two commonly used X Window System modifier keys, Alt
and Mode Switch, to keys on your keyboard.

To find out which keys to use, open the MAE Keyboard control panel. To
learn how to assign the keys to different keys on your keyboard, see
“Reassigning Modifier Keys” in Chapter 9 of this manual.

Mouse buttons

This book often refers to the mouse button, because the Macintosh operating
system (Mac OS) was designed to be used with a single-button mouse. The
phrase “the mouse button” refers to the first button (often called “the leftmost
button” or “Mouse Button 1”) on a mouse or trackball with multiple buttons.
For example, if a step instructs you to press the mouse button, press the first
button on a three-button mouse.

You can use X window features to change the mapping of the mouse buttons.

Basic mouse and keyboard operations

In this manual, some terms represent a series of actions that you perform with
the mouse, keyboard, or both. For example, the word “enter” indicates that
you type a character (or a series of characters), and then press the Return key.
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Here is a list of standard terms for mouse and keyboard operations and the
meaning of each term.

Term Action

Click Press and then immediately release the mouse button.

Double-click Press and release the mouse button twice in quick succession without
moving the mouse.

Drag Position the pointer on an item on the screen. Press and hold down the
mouse button while moving the mouse until you have accomplished
the desired task, such as moving the icon to a new location, and then
release the mouse button.

Choose Activate a command in a menu by positioning the pointer on the menu
title and dragging (usually downward) through the menu until the
command you want is highlighted. Then release the mouse button.

Select Designate where the next action will take place. To select an object
such as an icon, position the pointer on the object and click the mouse
button once. When selected, the object appears highlighted. To select
text, drag across the text until the entire range of text that you want to
select is highlighted.

Type Type a series of characters without pressing the Return key.

Press Press a single key or key combination without pressing the Return key
afterward.

Enter Type a series of characters and then press the Return key.

Where to go for more information

You can find helpful information about MAE in a number of different sources.
In addition to the onscreen documents such as this one, MAE includes
onscreen help in the form of Balloon Help, Apple Guide, and Toolbar help,
which are briefly described in this section. Late-breaking MAE information is
provided in the Read Me file. You can find information on the MAE Web
page that may be even more up-to-date. You can find the MAE Web page at
http://www.mae.apple.com.

To use an onscreen document, double-click the document icon located in the
docs directory in your home directory. For details on using the onscreen
documentation, see the online documentation for the Acrobat™ Reader.
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Manuals provided with MAE

In addition to this onscreen manual, the Macintosh Application Environment
Administrator’s Manual (referred to here as the MAE Administrator’s Manual)
is shipped with the Macintosh Application Environment (MAE).

The onscreen Macintosh Application Environment Administrator’s Manual
contains information on placing MAE on a server for installation onto separate
workstations, resource requirements (cache, memory, and disk), installation
packages, networking and license management.

The Read Me file (README.TXT)

MAE also includes an onscreen Read Me file, which provides late-breaking
information at the time this version of MAE was released, and troubleshooting
information about installing and using MAE on your workstation. The Read
Me file also explains how to get the most current MAE information, provided
by Apple on the World Wide Web.

The Read Me file (named README.TXT) is located in the root directory of the
Macintosh Application Environment CD-ROM disc. You can view the Read
Me file by using the SimpleText application within MAE or by using a
standard UNIX tool, such as more(1) or vi(1).

Balloon Help

MAE comes with a feature called Balloon Help, which provides immediate
onscreen help when you need it. If you want to know more about a window,
button, menu, command, or icon in the MAE window, use Balloon Help to get
the information you need.

Many Macintosh programs also have Balloon Help.

To use Balloon Help, click on the question mark at the right end of the menu
bar and choose the Show Balloons command. Now, balloons containing
explanatory text appear next to objects that you point to on the screen. To turn
off Balloon Help, choose Hide Balloons from the question mark menu.
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MAE Toolbar help

MAE provides immediate onscreen help for the MAE Toolbar when you need
it. If you want to know how to use a feature of the Toolbar, click the Get
Toolbar Help button at the right end of the Toolbar.

MAE information on the Web

Apple maintains a World Wide Web page to provide you with updated
information about MAE. You can also find the most up-to-date versions of the
MAE manuals on the MAE Web page. You can reach the MAE Web page at
http://www.mae.apple.com.

MAE Guide

MAE Guide is an onscreen tool that explains tasks step-by-step. To use MAE
Guide, choose MAE Guide from the Guide menu (indicated by the question
mark icon) in the menu bar.
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1 Installing the Macintosh Application Environment

This chapter describes how to install the Macintosh Application Environment
(MAE) software, the MAE onscreen documentation, AppleTalk, the reference
manual pages, and Macintosh demonstration applications on your UNIX
workstation. It describes how to perform the following tasks:

m starting the MAE installer locally on your workstation

m starting the MAE installer remotely from a server on the network

m installing the MAE software by using the Easy installation option

m installing selected MAE software packages by using the Custom
installation option

m removing MAE from your workstation

In addition, this chapter lists the resources needed to run MAE and includes
troubleshooting information about error messages that may appear during
the installation.
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What you need to install and run MAE

To run MAE, you need the hardware and software listed in the following
sections.

For all users

Everyone who wants to run MAE needs the following:

m a UNIX workstation that supports MAE

m a minimum of 35 megabytes (MB) of free disk space. (If you want to install
AppleTalk, the onscreen documentation, and the demonstration
applications, you need approximately 66 MB of total disk space.)

m a minimum of 32 MB of RAM (48 MB of RAM is recommended)

m an X Window System server, Version 11, release 5 or later

m the Macintosh Application Environment CD-ROM disc

m a PostScriptTM-compatible printer or an AppleTalk printer, if you want to
print from MAE

m a CD-ROM drive, or access to one over a network (if you are installing
from a CD-ROM disc)

m a floppy disk drive, if you want to install applications from floppy disks

Note:  If your company or organization has a license to have multiple users of
MAE, your system administrator may make the MAE files available to you for
remote installation from a server. If this is the case, you do not need the MAE
CD-ROM disc or a CD-ROM drive in order to install MAE. For information
about MAE licensing requirements, see the license agreement that comes
with MAE.

For Solaris users

If you use Solaris, you need the following:

m Solaris 2.5 or later

m Volume Manager patch. Consult the MAE World Wide Web page for
information about the latest patch.

The command /etc/showrev -p lists all installed patches.



Chapter 1 /  Installing the Macintosh Application Environment 19

For HP-UX users

If you use HP-UX, you need the following:

m HP-UX version 9.05 or 10.10. (Version 9.05 requires a patch to run over an
FDDI network—see the README.TXT for more information. Version
10.01 is not supported.)

m STREAMS/UX installed for versions before 10.10. If you plan to install
AppleTalk, STREAMS/UX must be installed on your system first.
STREAMS/UX is included with MAE.

m the Hewlett-Packard Audio Server if you are running HP-UX. For
information on patches that may be needed, see the MAE Web page.

Before you begin

Read this section before you install MAE on your workstation.

About the MAE software

The MAE CD-ROM disc contains the following MAE software:

m the Macintosh Application Environment package, including Macintosh
system software and Macintosh utility programs

m the software your workstation needs for AppleTalk networking capabilities

m the Onscreen Documentation package. (See “Manuals Provided With
MAE” in the Preface for descriptions of the onscreen guides.)

m the Acrobat Reader for UNIX and for Macintosh systems

m the Volume Manager Extension package for Solaris users

m Common Desktop Environment (and VUE, if applicable)

m FLEXlm License Manager server software

m demonstration versions of Macintosh applications, which can be installed
with the Custom installation procedure described later in this chapter
(optional)

m the Read Me file (README.TXT)

WARNING  You can use the MAE version 3.0 installer to upgrade a MAE
version 2 system. You cannot use the MAE version 3.0 installer to
upgrade a MAE version 1 system.
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Installation options

The MAE installer lets you install MAE on your workstation from a local
CD-ROM drive or from a remote server on the network. The installer offers
you the following choices:

m Easy installation: This option lets you install a default set of the MAE
packages in a single directory. Kernel modules are installed directly into the
UNIX kernel. When you choose this option, the installer installs the MAE
application, all packages that must be installed into the UNIX kernel, and
the onscreen documentation. Since some packages are installed into the
kernel, you need to have superuser privileges to install those packages. This
installation requires 45 MB of space available in the installation.

WARNING  MAE is incompatible with AppleTalk versions that weren’t
developed by Apple Computer. Do not install AppleTalk for MAE on
your workstation if you already have AppleTalk installed on the same
workstation. Before you install AppleTalk for MAE, remove the existing
version of AppleTalk. (Refer to the instructions that came with the
existing version.)

m Custom installation: this option lets you select the MAE packages you
want to install and specify where you want them installed. You can install
the packages in a single directory or in different directories.

m Remove: this option lets you remove the files that were installed when you
previously installed MAE. The Remove option is not for updating MAE; it
is for removing it from your workstation.

Overview of installation steps

The installation steps can be summarized as follows:

1 Obtain a license key to run MAE.

You can install MAE without a correct license key, but you need one before
you can run it. See the Read Me and LIC_REG files for details.

2 Select your installation medium.

Choose whether you want to install MAE from a CD-ROM drive attached to
your local workstation or from a remote Network File System (NFS) server.
(See “Mounting the Files From a Local CD-ROM Disc ” or “Mounting the
Files From a Remote Server,” later in this chapter.)
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3 If you are upgrading from a previous version of MAE, back up all modifications that have
been made to the apple directory, especially in the main System Folder directory,
apple/sys.

The installer archives your existing apple directory during the MAE
installation process, but removes the archived files upon successful completion
of the installation. Application components that may have been placed into the
apple/sys directory include but are not limited to these:

m Fonts

m Extensions

m Control panels

m Preference files

m File format translators

m Application-specific folders

m Startup items

m Shutdown items

m Apple Menu items

Removing application components from the apple/sys directory can render
applications unable to run. After installing MAE, you can add those items
back into the new apple/sys directory.

When MAE updates your system, it enables all standard Mac OS extensions
and control panels. If you had disabled standard extensions prior to
installation, you need to manually disable them again after you complete the
installation.

Note: Installing MAE over a previously installed version updates System
Folders of individual users while preserving modifications that had been made
to those System Folders. Also, MAE 2.0 created aliases in users’ home
directories that referenced several special folders that do not exist in MAE 3.0.
The MAE 3.0 installation program does not remove these aliases—you need to
remove these manually.

4 Run the installer and specify whether you want to perform an Easy installation or a
Custom installation, or whether you want to remove a previously installed version
of MAE.

See “Performing an Easy Installation,” “Performing a Custom Installation,” or
“Removing MAE,” later in this chapter.
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5 Install your license key in the license.dat file.

Refer to the license file and the MAE Administrator’s Manual  for detailed
installation instructions.

IMPORTANT  If you are planning to run MAE from a central server, you must
install the UNIX kernel modules (AppleTalk, the Solaris Volume Manager
Extensions, and STREAMS, if applicable) on your local workstation. For
further information, see Chapter 2 of the MAE Administrator’s Manual.

Getting access to the installation files

The following two sections describe how to find and use the MAE installation
files on a  CD-ROM disc (local or remote), or a remote server or CD-ROM
drive.

Note:  You need a current and correct license key to run MAE once you have
completed the installation process. For further information, see your system
administrator or read the Read Me file (README.TXT) in the root directory of
the MAE CD-ROM disc.

You must have superuser (“root”) privileges to install kernel modules, such as
AppleTalk and the Solaris Volume Manager Extensions.

Note:  Before you start MAE for the first time, you should log in using an
ordinary user account. This practice avoids creating a System Folder in the
root directory, and it allows you to use your own customized System Folder in
your home directory.

If you reinstall MAE over a previous installation, you must reinstall with the
same login you used the last time you installed. Thus, if you installed as root
previously, you must do so again.

Remember to install any necessary patches (or other software listed in the
Read Me file) before installing MAE.

Mounting the files from a local CD-ROM disc

To start the installer, follow the steps listed in this section.

IMPORTANT  Don’t use the Solaris File Manager to start the installer if you are
installing MAE on a workstation running Solaris. Start the installer in a Shell
Tool or a Command Tool window, using the command-line interface.

1 Open a terminal emulator window on your UNIX workstation.

For example, open a Command Tool or a Shell Tool window on a Sun
workstation, or an hpterm window on a Hewlett-Packard workstation.
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2 Insert and mount the Macintosh Application Environment CD-ROM disc.

IMPORTANT  You may need superuser privileges to mount a CD-ROM disc.
See your system administrator for information.

Some workstations automatically mount a CD-ROM disc when you insert
it into the CD-ROM drive. Other workstations require that you use the
mount(1M) command. Your workstation may require that you mount
the CD-ROM disc as read-only. For more information about mounting a
CD-ROM disc, see the documentation that came with your workstation.

3 Use the cd(1) command to change to the directory at which the MAE CD-ROM disc is
mounted.

For example, you can enter cd /cdrom at the command prompt.

Note:  If you are running Solaris, you might need to enter cd /cdrom/mae
to change to the directory where the MAE CD-ROM disc was automatically
mounted.

To install MAE, proceed to “Starting the Installation,” later in this chapter.

Mounting the files from a remote server

Your system administrator may have stored MAE on a network server or
mounted the MAE CD-ROM disc on a remote server. This section tells you
how to start the installer from a remote server.

Note:  Before you start the installer, make sure that you know which directory
on the server contains the MAE installation files, and be sure that you have
read permission for that directory.

To start the MAE installer on a remote server:

1 Open a terminal emulator window on your UNIX workstation.

For example, open a Command Tool or a Shell Tool window on a Sun
workstation, or an hpterm window on a Hewlett-Packard workstation.

2 Mount the remote server that contains the MAE installation files.

For example, if you are running HP-UX, mount the server at the /mnt
directory by entering the following:

mount -r remote-host:/directory-path /mnt

Replace remote-host with the name of the server and directory-path with the
name of the directory that contains the MAE installation files (or the MAE
CD-ROM disc). The -r option mounts the server as read-only.

IMPORTANT  You need superuser privileges to mount the server remotely on
your workstation. See your system administrator for information.
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3 Use the cd(1) command to change to the directory on the remote server in which the
MAE installation files are located.

For example, you can enter cd /mnt if you mounted the server according to
the example given in step 2.

IMPORTANT  Once the MAE CD-ROM disc is mounted, be sure to read the
Read Me file (README.TXT), which is located in the root directory of the disc.
The Read Me file contains information that supplements the information in
this manual.

To install MAE proceed to the next section, “Starting the Installation.”

Starting the installation

Once you have access to the MAE installer, install the MAE software as
follows:

1 At the command prompt, enter the following command:

./INSTALL.SH

If you do not have superuser privileges, the installer displays the following
message:

If you do not see this warning, continue with step 2.

If you see this warning, you can do one of the following:

m If you do not want to install kernel modules, press Return and continue with
step 2. (You can install the kernel packages later.)

m If you want to perform a complete installation, quit the installer by pressing
Control-C, log in as the superuser (root), and then start the installer again
by repeating step 1.
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2 Read the Welcome message.

The installer displays a welcome message.

Easy installation, custom installation, and removal of MAE are described later
in this chapter in “Performing an Easy Installation,” “Performing a Custom
Installation,” and “Removing MAE,” respectively.

Note:  You can quit the installer at any time by entering q (or quit). You can
display help information by entering help.

If you are well acquainted with the installation process, you can use command-
line options to shorten the installation process. See the section, “Using
Command Options With the Installer,” later in this chapter.

3 Press Return to continue.

The installer displays a list of packages available for the Easy and Custom
installations, including space requirements for each package.

If you are not logged in as the superuser, you will not be able to install
AppleTalk or the Solaris Volume Manager extensions. If this is the case, you
can do one of the following:

m Continue the installation; then install the kernel packages later.

m Type q to quit the installer. You can then log in as the superuser and return
to step 1 to start the installer again.
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4 Press Return again to continue.

The installer displays three installation options: Easy, Custom, and Remove.

To use the Easy installation option, see “Performing an Easy Installation,”
next.

To use the Custom installation option, see “Performing a Custom Installation,”
later in this chapter.

To remove MAE or one or more MAE packages, see “Removing MAE,” later
in this chapter.

Performing an Easy installation

When you perform an Easy installation, the installer installs the MAE
application and the onscreen documentation. In addition, if you have superuser
privileges, it installs the required kernel modules.

WARNING  MAE is incompatible with AppleTalk versions not developed
by Apple. Do not install AppleTalk for MAE on your workstation if you
already have AppleTalk installed on the same workstation. Before you
install AppleTalk for MAE, remove the existing version of AppleTalk
(according to the instructions that came with that product).

During the installation process, you can quit by entering q (or quit). You can
display help information by typing help.

1 When prompted to choose an installation mode, enter e (or easy).

The installer asks you where you want to install the MAE files.
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2 Enter the destination directory into which you want to install the MAE files, or press
Return to accept the default directory.

The installer recommends creating a directory called apple for the MAE files.
Although the apple directory can be located in any directory for which you
have write permission, it is preferable that the apple directory be created in
your home directory. (When you run MAE, you need only read and execute
permission for the apple directory.)

For example, if your home directory is named benjamin and its pathname is
/users/benjamin, you would type /users/benjamin/apple to specify
that the MAE files be installed in the apple directory in your home directory.

WARNING  Once the installer has created an apple directory and has
installed MAE into it, do not move the apple directory to another
location. If you do so, MAE will not be able to locate files it needs unless
you use the appledir command option when you start it. (See “Using
Options With the mae Command” in Chapter 2.)

The installer determines whether the destination directory is valid. For
example, it determines whether the destination directory has enough free disk
space.

Do not choose a destination directory that ends in a special character such as
+, -, or &.

3 Enter y (or yes) to confirm that you want to install the packages listed.

If the destination directory is valid, the installer displays a list of packages that
will be installed and asks if you want to begin installing them.

If the directory is not valid, the installer displays a message describing the
problem and prompts you again to select the Easy or Custom installation.

If you enter n (or no) when asked if you want to install the packages, the
installer returns you to the opening screen. (See step 2 in “Starting the
Installation,” earlier in this chapter, for information.)
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4 Press Return to begin installation.

IMPORTANT  If you need to stop installation once it has begun, press Control-C.
The installer removes any partially installed packages and then quits.

During installation, the installer displays status messages. When the installer
completes installation, it tells you where the log file is. The shell prompt then
appears.

5 Install your license.dat file, if required.

The license.dat file contains the information that allows you to use your
licensed copy of MAE. You may have to install this file or replace it with a
new one to activate your license. See your system administrator for further
information.

6 If you have installed AppleTalk, restart your workstation.

Kernel modules, such as those installed as part of AppleTalk, do not take
effect until your workstation has been restarted.

IMPORTANT  If the installer displays an error message during the installation,
see “If You Have Problems Installing MAE,” later in this chapter, for
instructions.

Performing a Custom installation

The Custom installation option allows you to install selected packages in a
single location or in several locations. For a description of the MAE packages,
see “About the MAE Software,” earlier in this chapter.

WARNING  MAE is incompatible with third-party AppleTalk versions. Do
not install AppleTalk for MAE on your workstation if you already have a
third-party version of AppleTalk installed on the same workstation.
Before you install AppleTalk for MAE, remove the existing version of
AppleTalk (according to the instructions that came with that product).

During the installation process, you can quit by entering q (or quit). You can
display help information by entering help.
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To perform a Custom installation, follow these steps:

1 When prompted to choose an Easy or Custom installation, enter c (or custom).

The installer asks if you want to install the package called “Macintosh
Application Environment.” This package contains the software necessary to
run MAE on your workstation.

2 Type y and press Return. If you don’t want to install the package, type n and press
Return.

If you typed y: The installer asks you where you want to install the files.
Go to step 3.

If you typed n: The installer asks you if you want to install the next package.
Repeat this step (step 2).

3 Enter the destination directory in which you want to install the MAE files, or press Return
to accept the default directory.

Note:  Some packages (such as AppleTalk) are automatically installed in
specific places.

The installer recommends creating a directory called apple for the MAE files.
It is recommended that the apple directory be created in your home directory,
though the apple directory can be located in any directory for which you have
write permission. (When you run MAE, you need only read and execute
permission for the apple directory.)

For example, if your home directory is named benjamin and its pathname is
/users/benjamin, you would type /users/benjamin/apple to specify
that the MAE files be installed in the apple directory in your home directory.

WARNING  Once the installer has created an apple directory and has
installed MAE into it, do not move the apple directory to another
location. If you do so, MAE will not be able to locate files it needs unless
you use the appledir command option when you start it. (See “Using
Options With the mae Command” in Chapter 2 of this guide.)

The installer determines whether the destination directory is a valid directory.
For example, it determines whether the destination directory has enough free
disk space.
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If the directory is not valid, the installer displays an error message describing
the problem and asks again if you want to install this package. Correct the
problem, then repeat step 2.

If the destination directory is valid, the installer asks if you want to install the
next package.

Do not choose a destination directory that ends in a special character such as
+, -, or &.

4 Repeat step 2 for each package that the installer asks you about.

When the installer has asked you about all the packages, it displays a list of the
packages you have selected and asks whether you want to have them installed.

5 If the list of packages is correct, press Return to install the packages.

If you want to add or remove a package, or if you want to change the
destination directory for any of the packages, enter n. The installation options
screen appears. To continue with a custom installation, enter c or custom,
and then return to the beginning of this section.

After you accept the list of packages by pressing Return, the installer copies
the MAE files to your system.

To stop the installation process once it has begun, press Control-C. The
installer removes any partially installed packages and then quits. If you want
to remove any packages that were completely installed, see the section,
“Removing MAE,” later in this chapter.

During installation, the installer displays status messages. When the installer
completes the installation, it tells you where the log file is. Your shell prompt
then appears.

6 If you have installed AppleTalk, restart your workstation.

IMPORTANT  If the installer displays an error message during the installation,
see “If You Have Problems Installing MAE,” later in this chapter, for
instructions.
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Installing MAE on a Diskless or Dataless Workstation

In order to successfully in stall MAE for dataless or diskless workstations,
write access to /usr, /kernel (Sun), /devices (Sun), and /etc/devlink.tab (Sun) is
required.  If you are installing as root, this should not present a problem; if you
are installing as other than root, you may need temporarily to have write
access to the necessary filesystems and directories.

Installing the License Manager

In addition to installing a license.dat file, each user running MAE must
have access to the License Manager. Usually, the system administrator installs
the License Manager on a server and users do not have to install it. However,
if you are the only user of MAE, you need to install it on your system and start
it before you can start MAE.

You install the License Manager during the custom installation. The License
Manager is package L8. During installation you can specify the location of the
License Manager—the default is the same location as MAE.

Removing MAE

The Remove option allows you to remove MAE from your workstation. Do
not use this option to install a newer version of MAE; use the Remove option
only to remove MAE (or parts of it) from your workstation altogether (for
example, if the disk space is needed). If you want to install MAE version 3.0
on a workstation running MAE version 1, first remove the older version with
the Remove option of the MAE version 1 installer.

The following procedure can be used to remove all or part of MAE. It assumes
that MAE is not running on the workstation, and that the installer is running,
as described in “Starting the Installation,” earlier in this chapter.

Note:  You cannot remove the demonstration applications with the installer.
You have to remove these independently.

To remove all or part of MAE, follow these steps:

1 When prompted to choose an installation option, enter r (or remove).

You see a list of packages that the installer can remove.
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2 Press Return to continue.

For each package, you are asked whether the installer should remove the
package, as shown in the following example.

The default response is No.

When you enter y (or yes), if the system is unable to find a package, it
prompts you to type the location of the package to be removed.

3 For each package, enter Yes to select it for removal, or press Return to leave it installed.

After asking about all the MAE packages, the installer lists those you have
decided to remove and asks whether to remove the packages.

4 To proceed with removing the packages,  press Return. To cancel the removal, enter No.

The default response is Yes. If you choose to proceed with removing the
packages, the system lists the packages and the number of files that it has
removed.

If you have not selected any packages to be removed, or if you choose not to
remove the selected packages, you are returned to the installation options
screen.

5 If you are running HP-UX and have removed the AppleTalk package, restart your
workstation.
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Using command options with the installer

If you are experienced in installing MAE, you can use options on the
command line to tailor the operation of the installer. The command and option
combinations are as follows:

INSTALL.SH  [-q][-R] -e [-d apple_directory]

INSTALL.SH  [-q][-R] -c [package_list]  [-d apple_directory]

INSTALL.SH  [-q][-R] -r [package_list]  [-d apple_directory]

The options are as follows:

q Suppress warning messages.

R Reboot the system after the installation. Required after installation of kernel
modules such as the AppleTalk kernel module.

e Perform the Easy installation process, installing the two basic MAE
packages:

m Macintosh Application Environment

m MAE onscreen documentation (user’s and administrator’s manuals)

This process provides detailed prompts (unless the q option is specified). It
is recommended for first-time installers of MAE.

d pathname

Specify the pathname (represented by apple_directory) of the apple
directory, where MAE is to be installed. You must specify the full
pathname.

c package_list

Perform the Custom installation process, installing the listed MAE product
component package or packages (specified by package_list):
E1_MAE Macintosh Application Environment 3.0, the

MAE executable program, and support files.
E2_ATALK AppleTalk Stack kernel module, which provides

AppleTalk support. The user must be logged in as
root to install this package.

E3_VOLD Solaris Volume Manager Extension, which allows
the use of Macintosh (HFS) floppy disks in the
floppy drive on a Sun workstation.

E4_DOCS MAE onscreen manuals, in PDF format, and the
Acrobat Reader application.

E7_DSKTP Common Desktop Environment (and VUE, if
applicable).

L8_LMGRD FLEXlm License Manager server software. Only
one is needed per network.
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P1_WORKS Demonstration version of the ClarisWorks
application.

P2_IMPCT Demonstration version of the ClarisImpact
application.

P3_DRAW Demonstration version of the ClarisDraw
application.

P4_FMPRO Demonstration version of the FileMaker Pro
application.

Separate package names with a space on the command line.

If you are installing kernel modules, use the -R option to reboot.

If you do not specify package names, the -c option behaves like the -e
option.

r package_list

Performs the Remove process, removing one or more previously installed
packages (specified by package_list). Separate package names with a space
on the command line.

If you are removing kernel modules, use the -R option to reboot.

If you have problems installing MAE

This section lists error messages that might appear during the installation
process and explains what to try in response. For additional information,
consult the MAE Web page at http://www.apple.mae.com.

ERROR: Not enough free space on [destination-directory]

Press Return to display the prompt that lets you enter a new destination
directory or press q to quit the installer.  If you want to install MAE in the
current destination directory, free some disk space and run the installer again.

ERROR: Cannot create directory [destination-directory]

You do not have the correct access permissions for the destination directory
that you selected. Press Return and enter a new directory or contact your
system administrator for the necessary permissions.
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ERROR: The installer encountered an unexpected error. No information is available for
this error.

The installer cannot determine what went wrong but is able to recover. If it
was installing a package, that package will be removed. If it was updating, the
original files will be restored.

ERROR: The installer cannot create the directory shown below.

You probably do not have permission to create a new directory in the parent
directory or the directory shown.

ERROR: Read-only filesystem.

This error is specific to AFS  filesystems on HP-UX. To avoid this problem,
install MAE on a local or NFS volume and copy the entire result (the apple
directory, the System Folder, and the .mac folders, if any) to your designated
AFS file system.

ERROR: The pathname that you have entered contains invalid characters. (For example,
do not use the '~' character when specifying a pathname.)

Choose a different file or directory path that does not contain the '~' character.
(Use environment variables such as $HOME instead of '~/'.)

ERROR: The installer cannot find any installation packages.

This can happen if the installation CD-ROM disc is mounted from a system
that converts the file names on the CD-ROM discs to lowercase. The installer
is case sensitive and is looking for specific file names that are all in uppercase.
It can also happen if the installer program (INSTALL.SH) is copied from the
installation CD-ROM disc but the required package files have not been copied
to the same location.

ERROR: An error occurred during the installation. Some packages could not be installed.

The installer was able to continue after an error occurred, perhaps during the
copy, verify, or finishing phase. Some packages may have been installed
without error, but the installer always removes packages that it fails to install
correctly.

ERROR: An error occurred during package removal. Some packages may not have been
removed.

The installer was unable to continue after an error occurred while attempting
to remove a package. Some packages might have been removed without error,
but the installer might leave packages in an unknown state if they cannot be
completely removed. This error is very rare. The best solution is to reinstall
the package in the same location, and then remove it again.
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If other problems arise during the installation process, see your system
administrator or contact Apple Technical Support.

File system problems

The MAE installation program does not have special knowledge of AFS
volumes so you might not be able to install directly on an AFS-mounted
volume. To install, go directly to the machine that contains the file system
and install locally.

Where to go from here

To begin using MAE, proceed to Chapter 2.
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2 Starting and Quitting MAE

This chapter describes the following:

m starting MAE

m quitting MAE

m solving problems that may occur when trying to start MAE
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Starting MAE

This section tells you how to start MAE from a command prompt in an
X terminal emulator window.

Note: A license key must be correctly installed in the license.dat file
before you can run MAE. See your system administrator for more information.

Before you start MAE, make sure that you know which directory contains the
mae program. If you did not specify a destination directory during installation,
the mae program is in the default directory, /opt/apple/bin.

IMPORTANT  If you installed MAE while logged in as root, you should log in
using an ordinary user account to start MAE.

To start MAE, follow these steps:

1 Open a terminal emulator window.

2 Enter the pathname of the mae program.

For example, if mae is located in the apple/bin subdirectory of your home
directory, and you are currently in your home directory, enter
apple/bin/mae & at the command prompt. (The ampersand causes MAE to
be run as a separate process, allowing you to continue entering commands in
the same terminal emulator window.)

An X window appears on your screen and displays MAE copyright
information. If you are starting this copy of MAE for the first time, the MAE
license agreement appears. Use the pop-up menu to choose the language you
want to use, then read the license. Click the Accept button to accept the terms
of the license and close the license agreement window.

After several moments, the MAE window appears.

Home directory
(MIV)

Menu Bar

MAE Toolbar 

Control Strip 

Trash

MAE desktop
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The first time a new user launches MAE, MAE creates the following
directories:

m System Folder—controls the operation of the Mac OS

m .mac—controls the function of MAE

m Apple Extras—contains useful Macintosh utilities and resources

MAE requires both the System Folder and .mac directories. By default, these
are in your home directory. You can change the location of these two
directories by using the -sysfol and -macdir options or by defining the
location using the MAE_SYSFOL and MAE_MACDIR environment variables
(see the section “Using Command Options With the mae Command” later in
this chapter and Appendix C for more information).

IMPORTANT  The files and directories in the .mac directory are critical to the
correct operation of MAE. Do not move or modify these files (except for
.MIV_file as described in Chapter 2 of the MAE Administrator’s Manual).

Running MAE from a remote computer
You can run MAE remotely (use MAE from your X server workstation when
the MAE process is actually running on an X client workstation connected
over the network). You might run MAE this way if, for example, you want to
use an AIX or IRIX workstation to run MAE.

Before you start MAE remotely, make sure of the following:

m You are authorized to run MAE on the remote computer and have the
required access privileges to run MAE.

m On the remote computer, MAE is installed properly, the information in the
license.dat file is correct, and you know the location of the MAE
executable file.

Note:  You do not need the license.dat file on your workstation to run
MAE remotely.

To start MAE remotely, follow these steps:

1 Open a terminal emulator window.

2 Enter the command xhost +clientname, replacing clientname with the name of the
remote computer on which MAE will run.

3 Connect to the remote computer by entering the command telnet clientname,
replacing clientname with the name of the remote computer on which MAE will run.

The remote computer must meet the requirements described in “What You
Need to Install and Run MAE,” in Chapter 1 of this manual.

4 Enter your login name (and password, if required) at the login prompts.
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5 Enter the command DISPLAY=servername=0; export DISPLAY, replacing
servername with the name of your workstation, on which MAE will be displayed.

Be sure to enter the command exactly as described above, including uppercase
and lowercase letters.

6 Enter the pathname of the mae program.

Note:  Because MAE is graphic intensive, it may run significantly slower over
the network.

Using options with the mae command

You can include options with the mae command. The following table lists a
few of the available options. For a complete list of options, see Appendix C.

The following table lists some of the options available for the mae command.

Command option Description

-help Display all the available command 
options for MAE.

-appledir directorypath Specify the location of the apple
directory. The default is the directory 
in which the MAE package was 
installed.

-display display Specify the X display server on which 
you want MAE to appear. The default 
is specified by the DISPLAY
environment variable.

-memory memorysize Specify the memory size for 
applications within MAE (in MB). The 
default is 16 MB.

-noextensions Disable Macintosh system extensions 
(has the same effect as holding down 
the Shift key while booting a 
Macintosh computer).

-sysfol directorypath Specify the location of the System Folder.
The default is your home directory.

-macdir directorypath Specify the location of the .mac
directory. The default is the your
home directory.

See the mae manual page or consult your system administrator for more
information.
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Using manual pages

MAE provides UNIX-style manual pages (man pages) to provide reference
information for the following commands:

m mae(1), which starts the Macintosh Application Environment

m appletalk(1M), which displays AppleTalk network information or starts
or terminates AppleTalk networking services

m appleping(1M), which sends packets to a particular AppleTalk node

m atlookup(1), which gets information about the network visible entities
registered on an AppleTalk network

m asdtool(1), which converts information between AppleSingle and
AppleDouble formats

m if you install the License Manager, man pages for license management
utilities are installed

To easily use the man command to display the mae manual pages, append the
full pathname of the MAE man page directory (/opt/apple/man, by default)
to the MANPATH environment variable.

If you are running Solaris, you can use the -M option with the man command
to specify the MAE manual pages directory, as follows:

man -M applemandirectory commandname

Replace applemandirectory with the full pathname of the manual pages
directory (/opt/apple/man by default).

Alternatively, you can move the man pages files from the apple directory to
the /usr/man directory.
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Quitting MAE

Quit MAE the same way you turn off a Macintosh computer:

1 Choose Shut Down from the Special menu on the MAE desktop.

This command quits all open Macintosh applications, puts away all mounted
Macintosh volumes (including CD-ROM discs and floppy disks), and closes
the MAE window. MAE performs all housekeeping tasks necessary for a clean
shutdown.

WARNING  The system maintenance tasks performed by the normal
shutdown process are essential to the successful operation of MAE.
Avoid using other methods to quit MAE (for example, by using
window manager capabilities available in your X environment).

2 If you are running MAE remotely, enter the command exit in the terminal window in
which you connected to the remote computer.

The exit command terminates your telnet session, closing your connection to
the remote computer.

The Shut Down command does not quit any X applications that may be
running, not even those you started from the MAE desktop, and it does not
shut down your workstation.

Note: You can terminate MAE by pressing Control-Shift-E. This approach
does not allow MAE to perform its important normal shutdown operations, so
you should use it only if MAE is frozen.

If you have problems starting MAE

This section lists error messages that might appear during the startup process
and explains what to try in response to each of them.

MAE cannot open the apple directory

An error message similar to the following may appear when you start MAE.

Unable to locate <apple_dir>
Please use the -appledir option to give the path to the apple directory.

This message appears if MAE can’t locate the directory that contains the
startup files for MAE.

You can specify the directory where the MAE files are located by using the
option -appledir directory-path with the mae command, replacing
directory-path with the name of the directory that contains the MAE files. See
the mae manual page for more information.
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If you cannot locate the MAE files, you may need to reinstall MAE. See
Chapter 1 of this manual.

You can’t see MAE in the X display

If you can’t see MAE in your X display, try the following:

If you are running MAE on the same workstation that is running the X display
server, set your DISPLAY environment variable to

local:0

If you are running MAE on one workstation and the X display server on
another, set your DISPLAY environment variable to the name of the
workstation on which the X display server is running and append the
characters

:0

For example, if you are running the X display server on a workstation named
my_machine, set the DISPLAY variable to the following:

my_machine:0

If MAE cannot connect to the X display server, run the xhost command on
the X display server workstation. For example, if MAE is running on a
workstation named my_workstation and the X display server is on a
machine named my_terminal, run the following command on
my_terminal:

xhost +my_workstation

This command allows MAE on my_workstation to open a display on
my_terminal.

On Solaris, the xhost command is located in /usr/openwin/bin. On
HP-UX, xhost is located in /usr/bin/x11.

Handling startup problems

If you experience problems starting MAE, try the following:

m Install MAE as the superuser, but log in using an ordinary user account to
start MAE.

If you start MAE as root, MAE tries to build a System Folder in the root
directory, which might not have enough free disk space. MAE must be able
to create the System Folder directory in your home directory or a directory
you have specified using the -sysfol command option or the
MAE_SYSFOL environment variable. In addition, if you start MAE as
root, you increase the possibility of deleting important workstation files
from within MAE.
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m Be sure that you have plenty of available disk space (at least 7 MB) in your
home file system.

The installer checks to be sure that there is enough free space to install
MAE. However, when you start up MAE for the first time, it builds a
System Folder in your home directory, which requires at least 7 MB of disk
space.

m Be sure that your home directory is local to the machine in which the MAE
process is running—that is, not connected through a remote mount point.
Although you can run MAE with your home directory on a remote
computer, it is not recommended because performance can be significantly
reduced.

The first time MAE starts, it scans the directories from the root directory to
your home directory. If there are remote mount points in that path, the scan
can cause delays or hang at startup.

m Check UNIX permissions on your home directory and the files and
directories within the apple directory. Permissions should not be a
problem unless you made changes while logged in with superuser
privileges.

m Check the RAM and available swap space of the workstation. MAE
requires a minimum of 32 MB of RAM and 16 MB of swap space;
48 MB of RAM and 64 MB of swap space are recommended.

m Ensure that you have the correct license.dat file and that it is in your
apple directory (or the directory selected by your administrator). See your
system administrator for more information.

m Ensure that AppleTalk is installed properly. AppleTalk installation must be
done as root on each system on which you want to run MAE. You cannot
simply copy your MAE binary files from machine to machine. The
AppleTalk installation correctly configures your kernel and creates device
files used by AppleTalk. If AppleTalk is not installed correctly, you might
see the following message:

/dev/appletalk/lap/ethertalk0/control Please be sure

the file exists
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m Ensure that you have restarted your workstation after installing kernel
modules such as those in the AppleTalk package.

m Ensure that the name of your .mac directory is unique—no other files or
directories should have the same name regardless of capitalization.

m Ensure the time zone variable, TZ, is set. Several routines within MAE use
the value specified by the environment variable TZ. Failure to assign a
value to this variable prior to executing MAE may result in an error.  You
can set this variable (in the ksh) with the command export TZ=PST8PDT

if you are located in the Pacific time zone. For more information, see the
appropriate man pages for your operating system.

m If MAE crashes during initial startup while MAE is creating (or updating) a
new System Folder, important aliases might not be created that are created
at the end of the installation process. Many aliases are put in the System
Folder that point to applications in the apple directory, and you will
experience performance problems.

If this happens, remove the newly created System Folder and restart MAE.
MAE creates a new System Folder for you. If you are updating MAE, you
can use your backup System Folder.

m If you get an error message referring to the .SMlock  file, ensure that no
other users are using the System Folder and remove the lock file.

Each time you start MAE, it looks for the .SMlock file in the System
Folder. If the file exists, MAE refuses to start; if the file does not exist,
MAE creates it. This prevents more than one MAE user from using the
same System Folder at the same time. Normally, this file is deleted when
you shut down MAE. If you are sure no one else is using the System
Folder, remove the .SMlock file and MAE will start.
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Problems with MAE independent volume (MIV) support

The following error messages related to independent volumes may appear
when you start MAE.

mmmm Can’t create the Mac file system structures.
This is a memory allocation problem.

This message indicates that the UNIX file system was unable to allocate
enough space for MAE’s external file system structures. It is recommended
that you increase the RAM in your workstation. For more information
about memory and swap space, see Chapter 4 of the MAE Administrator’s
Manual.

mmmm Can’t create pathname.
You need READ/WRITE access permissions.

The value pathname is the full UNIX pathname to the file .MIV_file.
These messages indicate that you do not have the required read/write
privileges for this file.

mmmm File pathname has invalid information in it.

The value pathname is the full UNIX pathname to the file .fs_info. This
message indicates that the data in the .fs_info file has become corrupted.
Rename the file for your system administrator to use in troubleshooting. To
recover your .fs_info file (and the associated .fs_cache file), consult
the MAE Administrator’s Manual.
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3 Installing Macintosh Applications

This chapter describes how to install Macintosh applications into MAE on
your workstation. It describes the following:

m using the application’s installation utility

m using the MAE independent volume (MIV) feature

m using the temporary installer volume (TIV) feature

m transferring files from a Macintosh computer
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Overview

There are several ways of installing Macintosh applications.

m You can use the installer program provided with the application.

m You can copy the files into a MAE independent volume (MIV) other than your
home directory and perform the installation from that independent volume.

IMPORTANT  If you copy the files to your system, use Mac OS operations to
transfer the files. If you use UNIX commands, the file modification dates
may not be preserved. Some installers require these dates to be intact before
they will install an application.

m You can install the application into the temporary installer volume (TIV),
described later in this chapter.

m You can copy the files from a Macintosh computer using floppy disks or a
networked file server.

IMPORTANT  Check with your system administrator before installing
applications or fonts. Files used by more than one MAE user on a workstation
can be installed in ways that save large amounts of disk space.

Installing with an application’s installer program

Install the application with its installer program as described in its documentation.

The installer usually allows you to choose the drive on which the application is
installed. Choose your home directory or a folder within your home directory.
If installation isn’t successful (for example, a message might state that you
don’t have enough disk space, when, in fact, you do), you can try using a
MAE independent volume (MIV) as described in the next section.

If the installer doesn’t allow you to choose the drive on which to install the
application, see your system administrator for help.

Note:  If the installation program does not complete, copy the contents of the
installation floppy disks to your hard disk and run the installation from your
hard disk.

WARNING  The installation programs for some applications add extensions
to the System Folder that might be incompatible with MAE. (For example,
HyperCard 2.3 installs the Speech Manager extension.) If you experience
problems after installing an application, start MAE with the
-noextensions option and remove any incompatible extensions or
control panels.
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Installing with a MAE independent volume (MIV)

A MIV is a UNIX directory that is mounted in MAE and functions like a
Macintosh volume. Files that are placed in a MIV can be manipulated from
both MAE and UNIX. To install an application using a MIV, copy the files
into the MIV and then run the copy of the installer program in the MIV or
select the MIV as your installation volume and use the application’s
installation program.

Note that copying files in the Finder by dragging them will not copy any
invisible files. Some applications cannot be installed without certain invisible
files from their installation disks.

WARNING  If you change your MIV configuration, applications that set
pathnames during installation may not work and you may have to install
the application again.

Note: When you install an application, it is best to install on a defined MIV.
This ensures that the files associated with the application have the correct
icon. For more information about defining a MIV, see the section “MAE
Independent Volumes” in Chapter 2 of the MAE Administrator’s Manual.

Installing with the temporary installer volume (TIV)

A temporary installer volume (TIV) is a virtual hard disk—a file on the UNIX
file system that acts within MAE like a Macintosh hard disk.

Note:  The temporary installer volume feature is supported to maintain
continuity with previous versions of MAE, but its functionality has been
superseded by MIVs. Before using a TIV, try copying the application files to
a MAE independent volume (MIV) and running the installer from the MIV.
See your system administrator for help.

To create and use a TIV, follow these steps:

1 Choose Control Panels from the Apple () menu.



50 Macintosh Application Environment User’s Manual

2 Double-click the MAE General icon to open it.

At the upper right of the control panel window is a section labeled Temporary
Installer Volume.

3 Type a number of megabytes in the Size box. Use a size sufficient to accommodate the
application you are installing (at least 10 MB).

If you’re not sure about the amount of disk space your application needs,
consult its documentation.

4 Click the Mount button.

The TIV icon appears on your desktop.

5 Double-click the TIV icon to open the TIV window.

6 Install the application according to its documentation.

If a message indicates that the Installer cannot find your System Folder, go to
the next section, “Problems With the System Folder.”

IMPORTANT  When you’re asked to choose a destination, be sure to specify TIV
(or the name of the TIV, if you have changed it).

Note: If your TIV is too small to accommodate the installation, drag it to the
Trash and create a new TIV with sufficient space.
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7 Drag the newly installed files from the TIV to your home directory.

8 If you are able to use the newly installed application from your home directory, drag the
TIV to the Trash.

If you are not able to use the application, see your system administrator for
help.

Problems with the System Folder

Some applications look for the System Folder when you install. In MAE, your
System Folder is usually in your home directory. If (and only if) the
application’s installer can’t find the System Folder, follow these steps:

1 The TIV must be large enough to accommodate both the System Folder and the
application (10 to 20 MB). If it isn’t, drag the TIV volume to the Trash and create a larger
TIV (see the previous section for instructions).

2 Drag the System Folder icon from your home directory to the TIV.

This creates a copy of the System Folder in the TIV.

3 Proceed with the installation.

4 Change the name of your original System Folder (for example, to System Folder.save).

5 When the installation is complete, drag the System Folder from the TIV to your home
directory.

WARNING  Do not copy the new System Folder unless you have already
changed the name of your original System Folder.

6 Drag the application files from the TIV to your home directory.

Your home directory has its original System Folder that looks like the
illustration below. The picture within the folder icon tells you that this is the
active System Folder.

The new System Folder that you copied from the TIV looks like this:
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7 Restart MAE by selecting Restart in the Special menu.

After MAE restarts, the small Macintosh icon should now be inside the icon of
the System Folder you copied from the TIV. This means that the new System
Folder is the active System Folder that is being used by your system.

If this is the case, drag your old System Folder.save to the Trash.

The installation is complete. The TIV will remain on your desktop until you
shut down MAE.

However, if the new System Folder has not become the active System Folder,
go to the next section.

If the new System Folder does not become active

If the new System Folder does not contain the active icon but the old System
Folder.save still does, restore your original System Folder as follows:

1 Change the name of the new System Folder (the one you dragged from the TIV volume).

For example, you might change it to System Folder.temp.

2 Change the name of the original System Folder (System Folder.save) back to System
Folder.

3 Restart MAE.

Your restored System Folder will not include any changes made during the
installation of the application. You can now remove System Folder.temp.

Try to install the application by transferring its files from a Macintosh, as
described in the next section.

Transferring files from a Macintosh computer

If you can install your application successfully on a Macintosh computer, you
can install it in MAE by transferring all the application’s files from the
Macintosh computer. To do so, follow these steps:

1 Install the application software on a Macintosh computer running system software
version 7.1 or later—preferably version 7.5.3 or later.

See the documentation that came with the application for instructions.

2 Locate the files and folders that you just installed.

Most or all of the files are usually in separate folders created by the
applications. (See the documentation that came with the application.) Check
for files related to the application in the System Folder and in the Preferences,
Fonts, Control Panels, Apple Menu Items, and Extensions folders (all inside
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the System Folder). If you are unable to find all the files for an application,
consult the product support department of the company that published the
application.

3 Transfer all the installed items from the Macintosh computer to your workstation.

Be sure to transfer all files to a place in MAE that is equivalent to their place
on the Macintosh. You can transfer the files by using one of the following
methods.

Using file sharing over the network:  This is the easiest method; it is described
in Chapter 7 of this manual.

Using an FTP utility over the network:  If the Macintosh computer on which
you installed the application software has File Transfer Protocol capabilities,
you can use an FTP utility (such as Telnet or Fetch) to transfer files from
the Macintosh computer to your workstation. The FTP utility must support
AppleSingle or AppleDouble file format. See the documentation that came
with the FTP utility.

Using 1.4 MB floppy disks:  If your workstation has a floppy disk drive, you
can copy the application software from the Macintosh computer to 1.4 MB
floppy disks. You may need to use several disks. Then, at your workstation,
insert each floppy disk and use the Finder in MAE to drag files from the
floppy disk icon to the folder icon representing your home directory (or to
a folder within your home directory). See “Mounting Floppy Disks and
CD-ROM Discs With the Toolbar” in Chapter 6 of this manual.

If an application file won’t fit on a floppy disk

Some application files are larger than 1.4 MB and thus cannot fit onto a single
floppy disk. You can use a Macintosh file-compression utility to compress
the file before copying it to the floppy disk. The file-compression utility must
be compatible with MAE so that you can expand the file once you copy it
to MAE.



54 Macintosh Application Environment User’s Manual

Opening and using Macintosh applications

Once your Macintosh application has been installed, use it just as you would
on a Macintosh. See the application’s documentation.

Note:  On a Macintosh, double-clicking a document icon usually starts the
application that created the document and opens the document. This capability
is supported through a mechanism called the Desktop file or Desktop database.
(This is the file being processed when you see the message “Rebuilding the
desktop file” upon starting up a Mac OS computer for the first time.) In MAE,
when you update the Desktop database, only the apple directory is updated—
updating the entire UNIX disk requires too much time and is not useful. As
a result, you may find that double-clicking a document doesn’t launch its
application, even though you’re sure the application is installed. To solve
the problem, open the folder enclosing the application and ensure that the
application icon is visible in the window. The Desktop database will then be
updated for that application, and you will be able to double-click documents
to launch the application. You can also force MAE to rebuild the Desktop
database for a specific directory by starting MAE and using the -applepath
pathname option with the -rebuild command option. When you use the
-applepath option, the directory you specify is rebuilt during startup.

Quitting Macintosh applications

You quit an application just as you do on a Macintosh. See the application’s
documentation.

Note:  On a Macintosh computer, you can press Command-Option-Escape
to terminate an application that is frozen or not running properly. This key
sequence is not supported by MAE.
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4 Printing in MAE

This chapter describes how to print documents in MAE. If you have
AppleTalk installed and are connected to an AppleTalk printer, you can
simply select a printer in the Chooser and choose Print from the File menu, as
you do on a Macintosh computer. If you do not have access to an AppleTalk
printer, you can print using a UNIX print command on a UNIX PostScript
printer using the Macintosh interface.

This chapter discusses the following topics:

m preparing for printing

m printing through AppleTalk

m printing to a UNIX PostScript printer

m printing from Macintosh applications

m solving common printing problems
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Setting up for printing

If you use a printer connected to your workstation through AppleTalk, printing
from MAE is the same as printing from a Macintosh. After the printer has
been connected to the network and set up properly, all you need to do is use
the Chooser to select a printer, then give your application’s Print command.
Selecting a printer is described in “Using the Chooser to Select an Appletalk
Printer” and in “Using the Chooser to Select a UNIX PostScript Printer,” later
in this chapter.

MAE can also be configured to use lp(1) or lpr(1), so you can send print
commands from an application running in MAE to a UNIX PostScript printer.

Note:  MAE supports only PostScript printers available through either the
UNIX printing mechanism or AppleTalk.

For instructions on using UNIX print commands, see “Using the Chooser to
Select a UNIX PostScript Printer,” later in this chapter.

The Chooser

When you select Chooser in the Apple () menu, the Chooser appears.

If you are connected through AppleTalk, and if your system administrator has
divided the area into AppleTalk zones, the Chooser will look something like
the following:

The icons in the box at the upper left represent the printer drivers and network
software available to you.
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The AppleTalk Zones box lists zones that a network administrator has
established. If there are no zones, the AppleTalk Zones box does not appear.

After you select an icon (and a zone, if appropriate), the box at the right lists
the devices available to you.

To set up your system to use your UNIX PostScript printer and the appropriate
UNIX print command, see “Using the Chooser to Select a UNIX PostScript
Printer,” later in this chapter.

Using the Chooser to select an AppleTalk printer

If your workstation is connected to a printer through AppleTalk, follow these
steps to select and set up the printer:

1 Select Chooser in the Apple () menu.

The Chooser appears on your desktop.

For a description of the Chooser, see the previous section.

2 Select the kind of printer you plan to use.

For example, in the illustration, LaserWriter 8 has been selected (in the box at
the upper-left corner of the Chooser).

3 Select the appropriate zone in the box at the lower-left corner of the Chooser.

If your network does not have AppleTalk zones, the AppleTalk Zones box
does not appear. Proceed to step 4.

4 Select the appropriate printer in the box at the right.

You must select a printer even if only one is listed.
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5 Click Setup.

The Chooser identifies the type of printer and automatically sets up the printer
software.

A small printer icon appears to the left of the printer name.

Note: If your printer has already been set up, clicking the Setup button opens
a printer setup dialog box, allowing you to view information about the printer
and to manually set advanced printer options. See your system administrator
for information about which of these advanced options are available.

6 Close the Chooser by clicking the close box at the upper-left corner of the Chooser
window.

You are ready to print. See “Printing From Macintosh Applications,” later in
this chapter, for further information.

Using the Chooser to select a UNIX PostScript printer

This section describes how to use UNIX commands to print from MAE. UNIX
print commands allow you to print from Macintosh applications without an
AppleTalk connection to your printer.

Note: If your workstation isn’t already set up for UNIX printing, see your
system administrator or the documentation that came with your workstation
for information about configuring UNIX printing services.

If you have more than one printer available, it’s a good idea to create a
separate print command for each printer so you can switch printers using the
Chooser. See “Creating a New Print Command,” later in this chapter.

Setting up the default print command

MAE provides a default print command, “Default lpr.” You must select a
PostScript printer description file (PPD) to be associated with the default print
command before you can print from MAE. The PPD file allows the LprWriter
printer driver to generate the appropriate PostScript files for your printer.

To set up the default print command, follow these instructions:

1 Open the Chooser in the Apple () menu.
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2 Click the LprWriter icon in the upper-left box.

If you have previously specified print commands, a list appears in the box on
the right. If you haven’t, only the “Default lpr” command appears.

3 Select “Default lpr” if it isn’t already highlighted.

4 Click Setup or press Return.

The Setup Print Command dialog box appears.

You can add options to the lpr command by typing them in the Print
Command text box. (See the lpr manual page for more information.)
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5 Click the Select PPD button.

A dialog box appears listing PPD files alphabetically by printer model. For
some files, a PostScript version number appears after the model name.

Some PPD files also list the amount of memory that the printer needs to use
the PPD file. For example, the PPD file “LaserWriter IIf v2010.113 2 MB” is
for a LaserWriter IIf with PostScript version 2010.113 and 2 or more
megabytes of memory.

6 Select the PPD file that best matches your printer’s characteristics.

When you select a PPD file, a description of the printer model appears at the
bottom of the dialog box. If more than one PPD file is available for your
model, select the file that matches the printer’s PostScript version and its
memory capacity for efficient operation.

Note:  If a PPD file is not available for your printer, click the Use Generic
button in the dialog box to select a generic PPD file, which provides basic
printing functions.

7 Click Select to confirm your selection of the PPD file and return to the Chooser.

You are now ready to print files in MAE. For instructions, see “Printing From
Macintosh Applications” later in this chapter.

Sources for PPD files

If MAE does not include the PPD file you need, you can obtain it from the
manufacturer of the printer or from Adobe™ Systems, Inc. When this manual
was published, Adobe maintained archives of PPD files on their ftp server at
ftp.adobe.com (130.248.1.4). The login is anonymous. Use your e-mail
address as the password. The PPD files are in the
/pub/adobe/printerdrivers/mac/all directory.
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Add the PPD file in the Printer Descriptions folder in the apple directory,
then select the file in the Chooser. You need root permission to add this file.

IMPORTANT  Installing new PPD files may not work if you do not have write
permission for your apple directory. Consult your system administrator to
add the necessary PPD file.

Creating a new print command

You can set up additional print commands by following the instructions in this
section.

To create a new print command, follow these steps:

1 Open the Chooser in the Apple () menu.

The Chooser window opens.

2 Click the LprWriter icon at the left side of the dialog box.
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3 Click the New button.

The Setup Print Command dialog box appears.

4 Type a name for the print command in the Command Name text box.

The command name you type will appear in the list of print commands in the
Chooser window. Use a descriptive name that includes the name of the printer
that you want to use.

5 Type a UNIX print command, such as lp or lpr, in the Print Command text box.

You can include any appropriate command options and arguments for the
UNIX command, as long as the command specifies a printer that supports
PostScript.

6 Click the Select PPD button.

A dialog box appears, listing the PPD files alphabetically by printer model.
For some files, a PostScript version number appears after the model name.

Some PPD files also list the amount of memory that the printer needs in order
to use the PPD file. For example, the PPD file “LaserWriter IIf v2010.113 2
MB” is for a LaserWriter IIf with PostScript version 2010.113 and 2 or more
megabytes of memory.
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7 Select the PPD file that best matches your printer’s characteristics.

When you select a PPD file, a description of the printer model appears at the
bottom of the dialog box. If more than one PPD file is available for your
model, select the file that matches the printer’s PostScript version and its
memory capacity for efficient operation.

Note:  If a PPD file is not available for your printer, click the Use Generic
button in the dialog box to select a generic PPD file, which provides basic
printing functions. The selection dialog box closes. Go to step 9.

8 Click Select to confirm your selection of the PPD file and return to the Setup Print
Command dialog box.

9 Click OK to close the Setup Print Command dialog box and return to the Chooser.

You are now ready to print files in MAE. For instructions, see “Printing From
Macintosh Applications” later in this chapter.

Sources for PPD files

If MAE does not include the PPD file you need, you can obtain it from the
manufacturer of the printer or from Adobe Systems, Inc. When this manual
was published, Adobe maintained archives of PPD files on their ftp server at
ftp.adobe.com (130.248.1.4). The login is anonymous. Use your e-mail
address as the password. The PPD files are in the
/pub/adobe/printerdrivers/mac/all directory.

Add the PPD file in the Printer Descriptions folder in the apple directory,
then select the file in the Chooser. You need root permission to add this file.

IMPORTANT  Installing new PPD files may not work if you do not have write
permission for your apple directory. Consult your system administrator to
add the necessary PPD file.
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Printing from Macintosh applications

In MAE, printing capabilities are controlled through the Print and Page Setup
dialog boxes, which you display by choosing commands from the File menu.
These dialog boxes should contain the same options as the examples in this
section, but your application may add additional options at the bottom. See the
documentation that came with your application for details about specific
options.

IMPORTANT  Before you begin printing Macintosh files, be sure that you have
followed the directions in “Setting Up for Printing,” earlier in this chapter.

Note: For information about setting up your workstation to print UNIX files,
see the documentation that came with your workstation.

Selecting Page Setup options
The Page Setup dialog box allows you to define certain characteristics of your
document, such as its page size, format, and orientation, as well as the settings
for several print effects. You can change these settings for every document
you create. It is recommended that you set your page setup options when you
first create a document. Then, as you view and format the document, it will
closely resemble its final printed form. Whenever you change printers, you
should also ensure that the Page Setup options are correct for your document.

Note: Some applications add options to the Page Setup dialog box. For
information about such options, refer to the documentation that came with the
application.

To select options in the Page Setup dialog box, follow these steps:

1 Choose Page Setup from the File menu.

The Page Setup dialog box appears.

2 Select the Page Setup options you want.

When you choose a Paper, Layout, or Orientation option, the page image on
the left side of the dialog box shows the result of your choice.

To see the currently selected page dimensions, click the page image. Click the
page image again to close the dimensions listing.
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3 To use special effect options, click the Options button.

The Options dialog box appears. Click the options you want to use, then click
OK to return to the Page Setup dialog box.

4 Click OK to close the Page Setup dialog box.

You are ready to print.

Printing Macintosh files

When you print from a Macintosh application on the MAE desktop, you
usually see a Print dialog box. You use this dialog box to specify print options
such as the number of copies you want printed, whether to print all or part of a
document, and which paper tray or cassette will be the paper source.

Note: Some applications add options to the Print dialog box. For information
about such options, refer to the documentation that came with the application.

To print a file created by a Macintosh application, follow these steps:

1 Make sure the file is open and active (the frontmost window), then choose Print from the
File menu.

The Print dialog box appears.

2 Select the options that you want.

3 Click the Print button.

The file is sent to the printer.
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Troubleshooting printing

MAE’s support for UNIX printers is very general; it is designed to work on a
wide variety of workstations and system types. This flexibility makes it
impossible for MAE to troubleshoot every possible printing configuration.
This section lists some commonly encountered printing errors. If you
encounter a printing problem that is not covered, consult your system
administrator.

Canceling a print job

When you print a Macintosh file on MAE, a printing status dialog box appears
for several seconds (depending on the size of the file). While the status dialog
box is on the screen, you can cancel printing by holding down the Command
key and pressing the period (.) key until the Canceling Printing dialog box
appears. To cancel printing after the status dialog box has disappeared, use
UNIX commands, such as lprm(1) or cancel(1). For more information, see
the appropriate manual pages (man pages) that came with your workstation or
consult your system administrator.

If the printer does not print anything

Check the X window in which you started MAE. MAE displays any error or
status messages in this window. The error messages can provide useful
information about why printing isn’t working.

You should also check the following:

m  Verify that the printer is turned on and properly connected to the network.
(For example, check for loose connections.)

m  Verify that UNIX printing has been configured correctly on your
workstation.

m  Verify that you have correctly set up a print command by using the Chooser
(available in the Apple menu on the MAE desktop). For example, make
sure that you did not accidentally type the wrong printer name in the Setup
Print Command dialog box.

m  Be sure you are looking for the printout at the correct printer. You may have
recently changed the print command to print on a different printer, or the
default UNIX printer may have changed. Some workstations use a UNIX
environment variable to specify the default printer. If the environment
variable has been changed, or if you are running MAE on a different
workstation, you may be printing on a different printer without knowing it.

m  Verify that the print queue contains your print request. Use lpstat or lpq
to check status. Also make sure that the print spooling system isn’t jammed.
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m  Verify that the print command that you specified in the Chooser actually
works if you type it directly into a UNIX command window. This step lets
you know whether your UNIX printing is working correctly.

m  Try printing the same file on another printer. This step helps you determine
whether the problem resides with the spooling system or with a particular
printer.

m  Try printing the file a second time, but this time click the Options button in
the Print dialog box and choose “Print detailed report” in the PostScript
Errors pop-up menu. This option prints any PostScript errors that may have
occurred. You can also print a cover page before printing the file. (Select
the Before button in the dialog box.) If the cover page prints, you know that
the file is making it to the printer.

The printed page contains “%!PS-Adobe-3.0” and other
miscellaneous text

Sometimes when you print a file, the page contains “%!PS-Adobe3.0”
followed by other miscellaneous text. This means that the PostScript program
is being printed as text, instead of being executed as code. This situation may
occur if you are trying to print your file on a non-PostScript printer. (If this is
the case, try printing your file on a PostScript printer.) The situation also may
occur if your UNIX printing does not recognize the PostScript identifier
“%!PS-Adobe-3.0,” which appears on the first line. See your system
administrator for help.

Only part of your document was printed

Printing can generate large PostScript files. If you do not have enough free
disk space, only a portion of your document may be printed.
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5 Using the Toolbar

This chapter describes the following:

m copying text or graphics between X applications and Macintosh
applications

m capturing screen images

m preventing the pointer from leaving the MAE window

m using Toolbar help

m hiding the Toolbar

These features use the MAE Toolbar, which is part of MAE, but not part of the
standard Mac OS.
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Overview

When you start MAE, the MAE Toolbar appears at the bottom of the MAE
window. The Toolbar provides several buttons that let you perform the
following tasks:

m mounting floppy disks and CD-ROM discs (see Chapter 6 of this guide)

m selecting images on your screen

m copying text and graphics between Macintosh applications and X
applications

m confining the pointer to the MAE window

m displaying onscreen help for the Toolbar

Mount Floppy/CD

Select from Screen

Import from X

Export to X

Contain Pointer

Get Toolbar Help

You activate a feature by clicking its button in the Toolbar. You can also
use the Toolbar pop-up menu. To display the menu, position the pointer
anywhere within the Mac OS part of the MAE window and press the third
(usually the rightmost) mouse button. To activate a feature, choose its
name from the menu.

The Toolbar pop-up menu includes all the functionality of the Toolbar. It also
contains the Hide Toolbar command, which allows you to temporarily hide (or
redisplay) the Toolbar. See “Hiding the Toolbar,” later in this chapter, for
more information.
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Mounting CD-ROM discs and floppy disks

To mount CD-ROM discs and floppy disks, use the leftmost icon on the
Toolbar or the Mount Floppy/CD command in the Toolbar Menu.

Mounting CD-ROM discs and floppy disks is discussed in detail in Chapter 6.

Capturing screen images with the Toolbar

MAE lets you select an area of your screen and capture an image of it. You
can then paste the image into a Macintosh or X application document.

To capture an image on your screen, follow these steps:

1 Click the “Select from Screen” button.

The pointer becomes a crosshair.

2 Drag the crosshair to select an area of the screen.

Position the crosshair on the screen, then press and hold down the first
(leftmost) mouse button while dragging so that the outline surrounds the area
of the screen you want to capture. Release the mouse button after you’ve
outlined the desired area.

This captures an image of the screen and places it on the Macintosh Clipboard.
You can paste the image into any active document window created by a
Macintosh application that accepts graphics in PICT format by positioning the
pointer where you want the image to be, clicking to create an insertion point,
and choosing Paste from the Edit menu.

You can store the image in the Scrapbook—a standard Macintosh desk
accessory. Simply perform steps 1 and 2, choose Scrapbook from the Apple
() menu, and then choose Paste from the Edit menu to paste the image into
the Scrapbook. Later, you can copy the image from the Scrapbook and paste it
into a document.

Note:  You can use the “Export to X” button to paste an image captured with
the “Select from Screen” button into some X applications. For more
information, see the documentation that came with the application.
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Importing text or graphics from an X document
to a Macintosh document

To copy text or graphics from an X document into a Macintosh document,
follow these steps:

1 Open and make active the X application document that contains the text or graphics you
want to import.

2 Select and copy the text or graphics.

Follow the X application’s procedures for copying. Some applications let you
copy text simply by highlighting it. Other applications require that you select
an item and then copy it by choosing a command from a menu or clicking a
button.

3 Click the “Import from X” button in the Toolbar.

The selection is copied to the Mac OS Clipboard.

4 Paste the text or graphics into a Macintosh document by using a standard Macintosh
command.

Exporting text or graphics from a Macintosh
document to an X document

MAE allows you to export text and graphics from a Macintosh document to an
X application document.

1 Open the Macintosh document that contains the text or graphics you want to import.

2 Select and copy the text or graphics in the Macintosh document.

Choose Copy from the File menu.

3 Click the “Export to X” button in the Toolbar.

The selection is copied to an X buffer.

4 Follow the X application’s procedure for pasting the text or graphics into an X document.

Some applications let you paste by clicking the second (usually the middle)
mouse button. Other applications provide a Paste command or onscreen
button.



Chapter 5 /  Using the Toolbar 73

Containing the pointer within the MAE window

As with most X Window applications, moving the pointer outside the
boundaries of the MAE window makes MAE inactive. If you do most of your
work within the MAE window, you may want to keep MAE active by
containing the pointer within the MAE window.

m Click the Contain Pointer button in the Toolbar.

The button changes to indicate that the pointer is contained, and the Contain
Pointer menu item changes to Release Pointer.

To release the pointer, click the button again.

Note:  If MAE stops functioning while the pointer is contained, you can’t use
the mouse to run X commands. You can type Shift-Control-E to force MAE to
shut down. If you do this, all unsaved data in the MAE window is lost.

Displaying Toolbar Help

You can display information about the features in the Toolbar while working
on the MAE desktop.

m Click the Get Toolbar Help button at the right end of the Toolbar.

The MAE Toolbar Help window appears on the desktop, displaying
information about each feature. Click the Done button to close the Help
window.
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Hiding the Toolbar

When you start MAE, the Toolbar appears at the bottom of the MAE window
by default. If you prefer not to see the Toolbar while you’re working, you can
hide it by using the Toolbar pop-up menu. While the Toolbar is hidden, you
still have access to its features through the Toolbar menu.

m Press the third mouse button and choose Hide Toolbar from the Toolbar pop-up menu.

The Hide Toolbar menu item changes to Show Toolbar.

To make the Toolbar reappear, press the third mouse button (usually the
rightmost) and choose Show Toolbar from the Toolbar menu.
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6 Using CD-ROM Discs and Floppy Disks

This chapter supplies basic information on mounting and using CD-ROM
discs and floppy disks with MAE:

m configuring your system for CD-ROM drives and floppy disk drives

m using the Toolbar to mount CD-ROM discs and floppy disks

m unmounting CD-ROM discs and floppy disks
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Using CD-ROM discs and floppy disks

MAE allows you to use three types of CD-ROM disc formats:

m Macintosh (or HFS)

m High Sierra

m ISO 9660 (including single-session Photo CDs)

MAE also allows you to use floppy disks of three formats:

m Macintosh (or HFS) High-Density  (1.4 MB)

m DOS High-Density (1.4 MB)

m ProDOS High-Density (1.4 MB)

To be able to use all of these types of disks or discs, you must have a properly
installed and configured floppy disk drive or a CD-ROM disc drive that
conforms to the Small Computer System Interface (SCSI). You must also have
the appropriate control panels and extensions installed correctly in your MAE
System Folder and loaded by MAE at startup. (All the necessary software is
included in the MAE package and installed by default.)

You can access a UNIX floppy disk by using UNIX commands to mount the
disk, and then using MAE to move to the mount point. The mounted floppy
disk appears as a MIV.

Note:  For simplicity, the term “removable media” will be used to refer to the
supported CD-ROM discs and floppy disks.

IMPORTANT  You cannot use a Mac OS hard disk drive formatted for HFS by
connecting it directly to your UNIX workstation. Attempting to do so can
damage data on your workstation or your hard disk.

Configuring MAE for SCSI CD-ROM disc and floppy disk drives

This section describes how to set up MAE so that you can mount removable
media on the MAE desktop.

When you install MAE, the installer creates a Preferences file called
macdisks.OS that contains information about your SCSI CD-ROM disc and
floppy disk drives. To use removable media on the MAE desktop, you must
edit the macdisks.OS file to provide MAE with information about the
appropriate SCSI drive. This file is located in the Preferences folder in your
System Folder (which is in your home directory).

Note: OS refers to the operating system you are using. For example, if you are
running HP-UX, edit the macdisks.HPUX file. If you are running Solaris, edit
the macdisks.Solaris file.
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You can configure MAE for removable media by using the default settings
provided by MAE or by customizing the settings, as described in the following
section.

Specifying settings in the macdisks.OS file

The following sections describe how to configure the macdisks.OS file for
CD-ROMs and floppy drives.

Editing the macdisks.OS  file for CD-ROMs

To edit the macdisks.OS file for CD-ROMs, follow these steps:

1 Shut down MAE by selecting Shut Down from the Special menu.

IMPORTANT  Never edit the macdisks.OS file while MAE is running.

2 Find out the SCSI ID number of your CD-ROM.

The SCSI ID number for an external drive can usually be seen on the outside
(often at the back) of the drive. Information about SCSI ID numbers can also
be found in certain configuration files on your workstation. See the
documentation that came with your workstation for more information about
such configuration files, or see your system administrator.

3 Use UNIX commands to go to the Preferences directory inside your System Folder.

4 Use any editor to edit the file called macdisks.OS, where OS is the name of the
operating system running on your workstation.

The file includes the following lines:

scsi0:ignore

scsi1:ignore

scsi2:ignore

scsi3:ignore

scsi4:ignore

scsi5:ignore

scsi6:ignore

5 Move to the line that corresponds to the SCSI ID number of your CD-ROM drive.

6 To specify a customized setting, skip step 6 and proceed to step 7. To use a default
setting, replace the word ignore with the word default. Then proceed to step 8.

When you start MAE, it will attempt to replace default with the appropriate
device description for your drive.

The macdisks.OS file includes additional recommendations about setting up
the file correctly for your workstation. For more information, see your system
administrator or check the documentation that came with your workstation.
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7 To specify a customized setting, replace the word ignore with specific information
about your CD-ROM drive.

The general format for SCSI device descriptions is

scsi#:removable:ro:device_name

Replace # with the SCSI ID number. What you type for device_name depends
on your workstation and the version of operating system you are using. For
example, if you are running HP-UX on your workstation and you want to
designate a CD-ROM drive at SCSI ID number 2, you might type the
following:

scsi2:removable:ro:/dev/dsk/c201d2s0 (For HP-UX 9.x systems)

scsi2:removable:ro:/dev/dsk/c0t2d0 (For HP-UX 10.x systems)

The macdisks.OS file includes additional recommendations about setting up
the file correctly for your workstation. If you need more information, see your
system administrator or check the documentation that came with your
workstation.

8 Save the file with your changes.

9 Start up MAE.

Proceed to mounting the CD-ROM disc by following the instructions in the
section, “Mounting Floppy Disks and CD-ROM Discs With the Toolbar,” later
in this chapter.

Editing the macdisks.OS  file for floppy drives

You configure floppy devices much as you do CD-ROMs, except that floppy
devices generally do not have SCSI ID numbers. With floppy drives, you only
need to enable the drive by entering whether the drive is read-only or read-
write and provide the device’s path name. By default, a floppy drive is
enabled.

To edit the macdisks.OS file for floppy drives, follow these steps:

1 Shut down MAE by selecting Shut Down from the Special menu.

IMPORTANT  Never edit the macdisks.OS file while running MAE.

2 Use UNIX commands to go to the Preferences directory inside your System Folder.

3 Use any editor to edit the file called macdisks.OS, where OS is the name of the
operating system running on your workstation.
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4 Move to the lines that correspond to floppy drives.

Floppy configuration lines have the format:

floppy0:default

floppy1:ignore

5 To specify a customized setting, skip step 5 and proceed to step 6. To use a default
setting, replace the word ignore with the word default. Then proceed to step 8.

When you start MAE, it will attempt to replace default with the appropriate
device description for your drive.

The macdisks.OS file includes additional recommendations about setting up
the file correctly for your workstation. For more information, see your system
administrator or check the documentation that came with your workstation.

6 To specify a customized setting, replace the word ignore with specific information
about your floppy drive.

The general format for SCSI device descriptions is

floppy#:[ro|rw]:/dev/device_path

Replace # with the floppy drive number. In device_path specify the device
path for the floppy drive. For example, if you are running HP-UX 10.10 on
your workstation, and if you want to designate a floppy drive, you might type
the following:

floppy0:rw:/dev/rfloppy/c0t1d0

or

floppy0:default

The macdisks.OS file includes additional recommendations about setting up
the file correctly for your workstation. If you need more information, see your
system administrator or check the documentation that came with your
workstation.

7 Save the file with your changes.

8 Starting MAE.

Proceed to mounting the floppy disk by following the instructions in the
section, “Mounting Floppy Disks and CD-ROM Discs With the Toolbar,” later
in this chapter.
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Loading required software

MAE requires that certain extensions and control panels be properly installed
in your System Folder and loaded before you can use removable media. The
MAE Easy Install process installs all the necessary extensions and control
panels and turns them on so that they are loaded when MAE starts. If one or
more of these extensions or control panels is moved, deleted, or turned off,
MAE does not recognize the associated removable media until the required
software is reinstalled and MAE is restarted.

In addition, floppy drives for Solaris systems require the Volume Manager
files and Volume Management to be enabled. The MAE Easy Install process
installs these by default if you install with root privileges.

The required Macintosh system components are as follows:

m Foreign File Access extension: allows the use of CD-ROM discs whose
contents are in a format other than HFS

m High Sierra File Access extension: with the Foreign File Access extension,
lets you use CD-ROM discs with High Sierra file systems

m ISO 9660 File Access extension: with the Foreign File Access extension,
lets you use CD-ROM discs with ISO 9660 file systems (including single-
session Photo CD discs)

m Apple Photo Access extension: with the Foreign File Access and ISO 9660
File Access extensions, lets you use Kodak Photo CD discs

m PC Exchange control panel: lets you mount ProDOS and DOS floppy disks
and associate Mac OS application programs with types of DOS files

To install one of these components, follow these steps:

1 Find the required extension or control panel.

Note:  Use only the versions of these components that are included with the
latest version of MAE.

2 Drag the extension or control panel to your closed System Folder.

MAE displays a message about where the components should be installed and
asks if you want them installed there.

3 Click OK.

The components are installed into the appropriate folder within the System
Folder. However, they will not be available for use by MAE until they are
turned on and MAE is restarted.
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Turning on extensions and control panels

When MAE starts, it loads all extensions and control panels that are properly
installed in the appropriate folders located in your System Folder (extensions
that are in disabled folders are not turned on).

To turn on an extension or control panel, follow these steps:

1 Choose Control Panels from the Apple menu.

2 Double-click the Extensions Manager icon.

The Extensions Manager control panel appears, listing the extensions and
control panels that are installed in your System Folder.

3 Click just to the left of the extension or control panel.

Position the mouse pointer just to the left of the item that you want to turn on.
When the mouse pointer becomes a checkmark, click the mouse button to
place a checkmark next to the item. The item is now turned on and will be
loaded by MAE the next time MAE restarts.

Mounting floppy disks and CD-ROM discs with the Toolbar

If your workstation has a floppy disk drive, you can mount a floppy disk,
displaying the floppy disk icon on the desktop.

IMPORTANT  You must use a high-density (1.4 MB) disk formatted for the Mac
OS, Windows, or DOS. You cannot use disks formatted for UNIX, nor disks
using nonstandard formats, unless you are willing to reformat them and lose
the data on them. See “Formatting Floppy Disks for the Mac OS” and
“Copying Files From 800K to 1.4 MB Floppy Disks” (later in this chapter).
To use installation floppy disks with compressed formats such as DMF, install
first on a Mac OS computer, then copy the files using AppleShare.

Before attempting to mount a CD-ROM disc on the MAE desktop, you must
first edit the macdisks.OS file. For instructions, see “Configuring MAE for
SCSI CD-ROM Disc and Floppy Disk Drives,” earlier in this chapter.

Note:  MAE does not support execution of UNIX commands from Mac OS
floppy disks.

Mount the floppy disk or the CD-ROM disc as follows:

1 Insert the disk.

2 Click the leftmost icon in the Toolbar.



82 Macintosh Application Environment User’s Manual

After a pause, a disk icon appears on the desktop. You can double-click this
icon to display the files or folders the disk contains.

Note: The first time you mount a Photo CD, you see the message “Creating
Photo CD Color Icons.” This process generates the “thumbnail sketch” icons
that represent the individual photographs on the CD.

Unmounting a floppy disk or CD-ROM disc

You must unmount a floppy disk or CD-ROM disc before you can remove it
from your workstation. On some workstations, the steps described in this
section may unmount and eject a disk. Other workstations require that you
manually eject a disk by pressing a button after you have unmounted the disk.

Note: If the disk is formatted for a UNIX file system, you can unmount it by
using appropriate UNIX commands; for example, umount(1M). See the
documentation that came with your workstation for information.

IMPORTANT  If you are running MAE on a workstation that requires you to
eject a floppy disk manually, make sure that you unmount the disk from within
MAE before you manually eject the disk. If you do not unmount the disk first,
you might lose information contained on it.

To unmount a floppy disk or CD-ROM disc, do this:

m Select its icon and choose Put Away from the File menu.

Alternatively, you can drag the disk icon to the Trash. Note that, as with any
Mac OS computer, dragging the disk icon to the Trash does not delete any
files from the disk.

Formatting floppy disks for the Mac OS

When you insert an unformatted floppy disk into a Mac OS computer, a
message asks if you want to initialize (that is, format) the floppy disk.

When you insert and mount a floppy disk in MAE, a similar message may
appear if one of the following conditions exists:

m The disk is formatted for UNIX. Click Eject to avoid losing information on
the disk.

m The disk might not be a high-density (1.4 MB) disk. Your workstation does
not support 400K or 800K floppy disks. Click Eject and remove the disk.
See “Copying Files From 800K to 1.4 MB Floppy Disks,” later in this
chapter.
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m The disk is damaged. If you know that the disk has already been initialized
for the Mac OS, eject the disk, then insert and mount it again. If the same
message appears, you may want to try using a commercially available disk
repair program.

m The disk has never been formatted.

If the floppy disk has not been formatted, follow these steps:

1 Insert the disk and click the Mount Floppy/CD button.

An alert box tells you that the disk is unreadable.

IMPORTANT  On some workstations, mounting an unformatted floppy disk on
the MAE desktop may take several minutes.

2 Click Initialize to format the disk.

An alert box tells you that the contents of the disk will be erased.

3 Click the Erase button.

If the disk contains information that you don’t want to erase, click Cancel.

Copying files from 800K to 1.4 MB floppy disks

Your workstation supports only 1.4 MB (high-density) floppy disks. You can
identify a high-density floppy disk by the words “Double-Sided High Density”
or “HD” on the disk.

If you have a Mac OS computer that can accept 1.4 MB floppy disks, you can
often copy the application software from the 800K disks to 1.4 MB floppy
disks by using the Mac OS Finder. This will not always work (for example, if
the installation disks have files that are not visible, you won’t be able to copy
them), but it will work in most cases. If you copy software installation disks
from 800K disks to 1.4 MB disks, make sure you follow these guidelines:

m Use one 1.4 MB disk for each original 800K disk.

m Initialize each 1.4 MB floppy disk on the MAE desktop before copying
files to it. See the previous section for instructions.

m Give each 1.4 MB disk the same name as the corresponding 800K disk.

m Copy all files from each 800K disk to the corresponding 1.4 MB disk.
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To copy files from an 800K disk to a 1.4 MB disk, follow these steps:

1 Insert the 800K floppy disk into the floppy disk drive on a Macintosh computer.

2 Drag the floppy disk icon to the hard disk icon on your desktop.

A folder with the name and content of the floppy disk is created on the hard
disk.

3 Eject the floppy disk by highlighting its icon and choosing Put Away from the File menu
or by dragging its icon to the Trash.

4 Insert a blank, newly initialized 1.4 MB disk into the floppy disk drive.

5 Give the 1.4 MB disk the same name as the original 800K disk.

6 Double-click the icon for the folder that you created on the desktop (and that now
contains the files from the 800K disk).

7 Choose Select All from the Edit menu.

8 Drag the contents from the folder icon to the icon for the 1.4 MB disk.

9 Eject the disk by highlighting its icon and choosing Put Away from the File menu or by
dragging its icon to the Trash.

Repeat these steps for each floppy disk that you will be using to install the
application software on MAE.

To lock a floppy disk (to protect its contents from being changed or erased),
use your thumb or a push-pin to slide the tab on the back of the disk so that the
square hole is open. To unlock the disk, slide the tab back so that it covers the
square hole.
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If you have problems mounting a floppy disk or CD-ROM disc

This section explains what to check if the following alert box appears when
you try to mount a floppy disk or CD-ROM disc, or if you have other
problems mounting disks.

m Sometimes MAE takes a few seconds to recognize a CD-ROM disc after
you insert and try to mount it. Click OK in the alert box, and then click the
Mount button on the Toolbar again.

m Make sure that the floppy disk or CD-ROM disc has been properly inserted
into the disk drive and that the drive is turned on.

m Verify that the disk drive isn’t already being used by a UNIX process, such
as the tar(4) or mount(1M) command. If the disk drive is being used, you
should be able to mount the disk when the UNIX process finishes running.

m Check with your system administrator to be sure that your floppy drive is
configured into the UNIX kernel.

On Solaris, verify that the Solaris File Manager is not using the disk drive.
If it is, use the File Manager to unmount the disk drive.

m Check with your system administrator to be sure that the device file
permissions are set correctly for the drive. You must be able to read the
device file in order to read the media. If you wish to write to a floppy, then
you must have permission to write to the device.

m If you are running more than one copy of MAE on your workstation, make
sure that the other copy of MAE is not using the drive.

m If you are trying to mount a CD-ROM disc, make sure that you have edited
the macdisks.OS file (in your System Folder) to include information
about your CD-ROM drive. For more information, see “Configuring MAE
for SCSI CD-ROM Disc and Floppy Disk Drives,” earlier in this chapter.

m If you are running Solaris, be sure that you have installed the Volume
Manager Extensions and that Volume Management is enabled. (See your
system administrator for help.)
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Troubleshooting floppy disks and CD-ROM discs

This section lists situations that you might encounter when using disks and
CDs with MAE 3.0 and describes how to respond.

Problems using floppy disks remotely

Although some X terminals export floppies as NFS file systems, thus
providing a convenient workaround, MAE does not in general provide remote
floppy support. For example, you can start MAE on a workstation and display
it remotely (using the -display option) on another workstation on the
network. If you display MAE remotely, you can use only floppy disks that are
inserted in a floppy drive attached to the workstation where you started MAE,
not where you are displaying it.

Floppy disk drives and performance

Floppy disk drives are much slower than hard disks, and leaving a floppy disk
in an X terminal drive can slow down MAE. Since MAE periodically scans
the directories displayed in open Finder windows, leaving a floppy disk in the
drive when the Finder has your home directory displayed in a window will
affect performance. Solution: Don’t leave floppy disks in the X terminal’s
drive.

MAE produces many dialog boxes when you press the Mount button

If you launch an application and then immediately click the Mount button on
the MAE Toolbar when a valid MAE floppy disk is in the drive, various
spurious dialog boxes may appear in the MAE window. If this happens, wait
for the application to finish launching, then press the Mount button again.
Dismiss the remaining dialog boxes.
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DMF floppy disk format

A new disk format (known as DMF—Distributed Media Format) permits
distribution of software on a smaller number of disks. DMF is a 1.6 MB
format which cannot be used by current PC-compatible (360K/720K/1.4M) or
Apple (400K/800K/1.4M) floppy disk drives unless read by the installer
program. The special installer modifies the hardware floppy disk driver to
support the new format. MAE does not use standard Macintosh drivers to
support floppy disk drives. As a result, the installer cannot be run from disks
that support DMF.

To properly install an application that uses this format, do one of the
following:

m install from a CD

m install from a disk set that does not use DMF

m install using a DMF disk set onto a native Macintosh and use AppleShare to
transfer the files to MAE

Sun-specific situations

The following situations are specific to Sun systems.

You cannot access the files on a MAE CD mounted remotely on a Sun
workstation

You may have a problem accessing the files on a remotely mounted MAE
CD-ROM disc if the disc was mounted on a Sun workstation by using the
Solaris Volume Manager. There are two possible solutions to the problem:

m Quit the Solaris Volume Manager and explicitly mount the MAE CD-ROM
disc by using a command such as mount(1). You should then be able to
access the files on the CD-ROM disc in order to perform a remote
installation.

m Copy the MAE files from the CD-ROM disc to a directory on the Sun
workstation and then access the files by remotely mounting the directory.
For more information about remotely installing MAE, see Chapter 1.

The message “fd0: read failed” appears

When you try to mount a floppy disk on MAE, you may see the message
“fd0: read failed” on your Sun console. This message alerts you that
Solaris is unable to read certain sectors on the floppy disk. Try another floppy
disk, or try the same disk on a different workstation. (If the disk does not
contain data that you need, you may want to reformat the disk and then try
mounting it again with MAE.)
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MAE displays an alert box about the Solaris Volume Manager

When you try to mount a floppy disk in MAE running on a Sun workstation,
MAE may display the message: “You will not be able to use Macintosh
floppies with MAE because the Solaris Volume Manager is not available
now.” If this message appears, use the ps (1) command to see if the process
vold (/usr/sbin/vold) is running on your workstation.

If vold IS NOT running, start the vold process as the root user and try
mounting the floppy disk again. (You may want to edit the appropriate Solaris
configuration files so that vold starts automatically when you start up your
workstation. For instructions, see the Solaris documentation.)

If vold is running, and you see an error message such as “/dev/volctl:
Permission denied” on your console, problem is with Solaris. As root, check
the access pthe ermissions on the file named in the error message (for
example, /dev/volctl). If necessary, change the permissions for the file
by using the chmod (1) command and give yourself access to the file. (If the
file is a symbolic link, you need to change the access permissions on the file to
which the link points.) After changing the access permissions, try mounting
the floppy disk on MAE again.

MAE is unable to access the floppy drive

Be certain you have read and write permissions on the floppy device file
symbolically linked to /dev/rdiskette. In addition, software products that
do not currently support the Solaris Volume Manager will conflict with MAE,
which does use the Volume Manager. Until software products that are
incompatible with the Volume Manager are upgraded to support it, you can
work around this conflict by turning the Volume Manager on when using
floppy disks or CDs in MAE and off when using other software. This
workaround is only necessary when accessing a Macintosh floppy disk or CD
since MAE doesn't use the Volume Manager until you try to access a
Macintosh disk. Be aware, too, that some software disables Volume Manager
control at the device level by changing your /etc/vold.conf file, rather
than starting or stopping the Volume Manager’s vold process.

Unable to access DOS diskettes when MAE is running

The Volume manager Dynamic Shared Objects (DSO's) "indent_macfs" and
"action_macfs" were modified in MAE 3.0 Update 4.  These DSOs identify
diskettes as being for MAE (that is, type macfs) only if MAE is running.
MAE requests exclusive use of floppies that are either Macintosh HFS or DOS
filesystems.  If you want to use a DOS floppy disk on your Solaris
workstation, but not from within MAE, you must shutdown MAE while you
use the floppy in another application.
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Solaris displays the “Unlabeled Floppy” dialog box on your console

When you insert and try to mount a Macintosh floppy disk on MAE, Solaris
displays the “Unlabeled Floppy” dialog box if you didn’t install the Solaris
Volume Manager Extensions when you installed MAE. (See Chapter 1 for
more information.) Click Cancel in the dialog box (do NOT click Cancel &
Eject). The floppy disk icon should appear on your MAE desktop. To avoid
this problem, you should eject disks that have been mounted on the MAE
desktop by using MAE capabilities only. For example, drag the disk icon to
the Trash or choose Eject Disk from the Special menu.

MAE hangs when a mounted floppy disk has been ejected

If a Macintosh disk is somehow ejected without MAE being notified (for
example, if you type “eject floppy” in a Solaris shell window or click Cancel
& Eject in the dialog box described earlier), MAE may hang until it is able to
use the disk again. Reinsert the disk and type “volcheck” in a Solaris shell
window. This step should allow MAE to continue to use the floppy disk on the
MAE desktop. To prevent this situation, run the MAE installer as root and
install the Solaris Volume Manager Extensions package (according to the
instructions in Chapter 1).

You have problems using a Solaris file system disk on MAE

If you insert a floppy disk formatted for Solaris into a Sun workstation and try
to mount it in MAE by clicking the Mount Floppy/CD button, MAE displays
an alert box. To use a floppy disk formatted for Solaris, follow these steps:

1 Insert the disk that contains the files that you want to use.

2 In a Solaris window, type volcheck floppy.

The files on the disk will appear in the /floppy/ directory on your UNIX file
system.

3 To access files on the floppy in MAE, open /floppy.

In order to access the /floppy directory, the root (/) MIV must be accessible
on your desktop. For example, if you have a symbolic link called Flop in your
home directory that points to /floppy, you can mount the “/” MIV by
double-clicking on Flop. (See the section “MAE Independent Volumes” in
Chapter 2 of the MAE Administrator’s Manual, for more information about
MIV configuration.) Once the root MIV is available on your desktop, double-
click the “/” MIV icon, then double-click the folder called floppy.

4 Double-click on the folder that represents your floppy file system.

The floppy appears in the /floppy directory as a folder with the same name
as the Solaris volume management label associated with that floppy. If the
floppy does not have a label, it appears as unnamed_floppy.
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See your system documentation for more information about the Solaris
Volume Manager and its treatment of floppy disks.

MAE hangs when you press the Mount button

If MAE seems to hang after you click the Mount button in the Toolbar with a
valid MAE floppy in the drive, type the following in a Solaris shell window:

volcheck floppy ; eject ; volcheck floppy

This should unstick the Solaris Volume Manager and allow you to continue.

HP-specific situations

The following situations are specific to Hewlett-Packard systems.

Floppy disk drives on HP “Envizex” X terminals

Some HP “Envizex” X terminals come with floppy disk drives. MAE is not
able to directly access floppy disks in these drives: the X terminal software, in
cooperation with the host UNIX system, controls the hardware. MAE has no
way to load executable code into the X terminal to control the device without
changing the operation of the drive. Thus, only MS-DOS floppy disks are
accessible through the X terminal’s floppy disk drive. They are mounted by
the host system software through NFS, and are accessable as $HOME/floppy.
If you are having problems using the floppy disk drive, contact your system
administrator, or consult HP’s documentation (for example, Chapter 4 in
“Using the X Station’s Hardware Accessories” in HP ENWARE X Station
Software 5.1, Technical Reference).

Using older (single-speed) CD-ROM drives

You may encounter a problem using older HP CD-ROM drives (single-speed
Toshiba XM-3301TA) with an HP Model 715 workstation. Typically, MAE
cannot mount a CD-ROM disc. There is a known SCSI timing problem when
the older drives are used with a Model 715. As a workaround, HP suggests
either placing another SCSI device between the 715 and the CD-ROM player
or using a SCSI cable longer than one meter and shorter than six meters.
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7 Networking with MAE

This chapter describes how to use Macintosh networking capabilities in MAE.
It contains information on the following:

m AppleTalk

m changing the network interface

m file sharing

m program linking

m MacTCP
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Understanding AppleTalk with MAE

AppleTalk is a network system designed and developed by Apple Computer.
The AppleTalk network allows users to connect easily to AppleTalk printers
and to share services with other AppleTalk devices while running concurrently
with TCP.

The Chooser

The Chooser is an application that gives you access to the AppleTalk network
services. To use the Chooser, select Chooser in the Apple () menu.

If you are connected to the network through AppleTalk, and if your system
administrator has divided the network into AppleTalk zones, the Chooser will
look something like the following:

The icons in the box at the upper left represent devices to which you can
connect or network services you can use. Selections you make in this box
determine the information that is displayed in the box on the right.

The AppleTalk Zones box lists zones that the system administrator has
established. If there are no zones, the AppleTalk Zones box does not appear.

Note:  Leaving the Chooser open as the active application with a Chooser
device (such as AppleShare) selected can cause significant network traffic. If
you prefer to keep the Chooser open, it is recommended that you keep it in the
background when not using it.
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AppleTalk commands

You can determine and control the status of AppleTalk by entering commands
that invoke utility programs (located in the apple directory). For detailed
information, see “UNIX AppleTalk Commands” in Chapter 5 of the MAE
Administrator’s Manual.

The commands are

m appletalk -s to determine the status of AppleTalk

m appletalk -D to turn AppleTalk off (requires superuser privileges)

m atlookup to list the network visible entities in a zone

m appleping to ensure that a node is alive

Sharing files through AppleTalk

Within certain limitations, MAE allows you to use the standard Mac OS file-
sharing capabilities to access other computers and servers and to share files
with other users. In a Mac OS file system, the person using the computer can
generally control ownership and access privileges for all the files on the local
file system. In a multiuser UNIX system, however, only the superuser has such
broad control, for obvious reasons.

To ensure that you control your own files in MAE without compromising
others’ control over theirs, MAE allows the superuser to restrict your ability to
use file-sharing capabilities as follows:

m You may be prevented from allowing guest access to your workstation.

m You may be prevented from sharing folders that you don’t own.

m You may be prevented from starting file sharing.

See your system administrator to find out what restrictions you have on file
sharing.

Note:  Any computer that has AppleShare or Mac OS file sharing turned on
and has made at least one volume available for sharing is considered a file
server.
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For more detailed information about Mac OS file sharing, see the Macintosh
Networking Reference published by Apple Computer (part number
030-3936-A).

WARNING  In most cases, a user should not share the root directory
without careful configuration of access privileges. For example, sharing
the root directory with read-only permission allows remote users to view
files such as /etc/passwd. Users should be especially cautious when
sharing folders on NFS volumes via file sharing. See “Sharing UNIX
Directories,” in Chapter 5 of the MAE Administrator’s Manual.

Changing the AppleTalk network interface

If you have more than one AppleTalk interface installed on your workstation,
MAE will select a default interface when it is started. To switch between two
or more AppleTalk network interfaces on your MAE workstation, select the
interface you want in the Network control panel as follows:

1 Choose Control Panels from the Apple () menu and double-click the Network icon to
open it.

2 Click the icon of the network connection you want to use.

A dialog box warns you that you may be disconnected from any network
services (such as printers or file servers) that you are using with your current
network connection. This means that you will have to reconnect to the network
services on the new network.

3 Click OK in the dialog box.

4 Point to the name of the current zone displayed in the Network control panel and press
the mouse button to open the pop-up menu of available zones.
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5 Choose the zone that you want.

6 Click the appropriate interface icon.

7 Close the Network control panel.

You can now use the network interface and zone you selected.

Accessing another computer with AppleShare

The AppleShare software allows you to use folders and files on a shared disk
on another computer, provided that the owner of the folders and files has made
them available. For information on how to make folders you own available to
other users, see “Making Your MAE Files Available to Others,” later in this
chapter.

To gain access to a shared disk or server, follow these steps:

1 Open the Chooser by selecting Chooser in the Apple () menu.

2 In the Chooser window, select the AppleShare icon at the upper left.
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3 In the AppleTalk Zones box, select the appropriate zone.

Click the zone of the server that contains the folders you want.

A list of file servers appears in the “Select a file server” list box.

4 Locate and click the appropriate server name, then click OK.

You can move through this list more quickly by clicking the “Select a file
server” list and typing the first few letters of the name you’re looking for.

A dialog box appears that allows you to identify yourself.

5 Click Guest or Registered User.

If Guest is dimmed, you must be a registered user to connect to the server.
Guests do not need passwords. If you clicked Guest, go to step 7.

6 If you clicked Registered User, type your user name in the Name box and type your
password in the Password box.

Your name and password are registered on the computer you’re connecting to.
See the owner of that computer if your name and password aren’t recognized.

7 Click OK.

An additional dialog box may appear that asks you to select a volume from a
list. After you do so, a shared disk icon appears on your desktop.

8 Double-click the icon to open it.

The window that appears contains the icons for the folders and files on the
computer or server to which you are connected. If you have the necessary
access privileges, you may use these folders or files as though they were on
your own computer.
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Note:  Some of the icons on your desktop may be for independent volumes
that represent directories or volumes mounted at some point in your UNIX file
system. See the MAE Administrator’s Manual for further information.

Making your MAE files available to others

This section describes how you can make files and folders in your MAE
desktop available to other Macintosh or MAE users.

WARNING  In most cases, a user should not share the root directory
without careful configuration of access privileges. For example, sharing
the root directory with read-only permission allows remote users to view
files such as /etc/passwd. Users should be especially cautious when
sharing folders on NFS volumes via file sharing. See “Sharing UNIX
Directories,” in Chapter 5 of the MAE Administrator’s Manual.

Note:  You should check the File Sharing Monitor to see that no one is using a
shared folder before changing its sharing status (by changing its access
privileges, changing its owner, or turning off sharing for it).

To make items on your MAE desktop available to other Macintosh or MAE
users, follow these steps:

1 Select Control Panels in the Apple () menu.

2 Double-click the Sharing Setup icon to open it.

3 Type your name in the Owner Name box and press Tab.

This is the name you use to gain access to your computer from elsewhere on
the network.
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4 Type a password in the Owner Password box and press Tab.

This is the password to use for gaining access to this computer. It is
independent of your UNIX password. When you press Tab, the characters of
your password are replaced by bullets.

5 In the Macintosh Name box, type the name of your computer.

This name appears in the “Select a file server” list in the Chooser.

6 If the File Sharing button is labeled Start, click it to start file sharing.

7 Click the close box.

Disconnecting from a shared disk

To disconnect from a shared disk, do this:

m Select the Shared Disk icon and choose Put Away from the File menu.

For information on setting access privileges, see the next section, “Access
Privileges.”

Access privileges

When you share a folder or a disk, you can set access privileges to files and
folders you own to specify who can use those shared files or folders. You may
also be able to allow access to guest users; see “Naming Specific Users,” later
in this section.

For each user or group of users, you can specify these three types of Mac OS
file-sharing access privileges:

m See Folders to open the folder.

m See Files to open any file within the folder.

m Make Changes to change the contents of the folder and any file within the
folder.

IMPORTANT  When MAE users export part of a UNIX file system via file
sharing, they can grant Mac OS file-sharing access only to the extent that the
UNIX permissions allow them that access. For example, if a MAE user does
not have write access to a file, the user cannot export that file with Mac OS
file-sharing write access. Thus, the privileges another user has when accessing
files are the most restrictive combination of the UNIX permissions and the
file-sharing privileges. See Chapter 5 in the MAE Administrator’s Manual.
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Differences between UNIX and Macintosh access permissions

The differences between UNIX permissions and Macintosh file-sharing
privileges can be summarized as follows:

m Macintosh file-sharing privileges affect file sharing over AppleTalk. UNIX
permissions affect permissions across all UNIX networks.

m All files and folders (directories) created within UNIX are assigned default
UNIX permissions automatically. Folders and their contents are assigned
Macintosh file-sharing permissions only if the owner of the folder has made
the folder available to others.

m UNIX permits the owner to assign different permissions to every item
within a directory. Macintosh file sharing allows the owner to set privileges
for the folder. These privileges are transferred to all the contents of the
folder collectively.

m In most cases, a user should not share the root directory without careful
configuration of access privileges. For example, sharing the root directory
with read-only permission allows remote users to view files such as
/etc/passwd. Users should be especially cautious when sharing folders
on NFS volumes via file sharing. See “Sharing UNIX Directories,” in
Chapter 5 of the MAE Administrator’s Manual.

The following table shows UNIX permissions compared with file-sharing
privileges:

If UNIX Permissions are then file-sharing privileges are

Read Write Execute See Folders Make
and See Files Changes

No No Yes No No

No No Yes No No

No No Yes No No

No No Yes No No

No No Yes No No

No No Yes No No

No No Yes No No

No No Yes No No

See also “Setting UNIX Permissions,” in Chapter 8 of this manual.

Note:  When files are shared through UNIX (not Macintosh File Sharing) by
more than one MAE user, it is possible to write over the other user’s changes.
This is standard in a UNIX environment.
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Setting file-sharing privileges

Set the access privileges to a folder or disk as follows:

1 Make sure file sharing is turned on in the Sharing Setup control panel.

See “Making Your MAE Files Available to Others,” earlier in this section.

2 Select the folder or disk.

3 Choose Sharing from the File menu.

The Sharing window appears.

4 Click “Share this item and its contents” to place an X in it.

You are now able to select the See Folders, See Files, and Make Changes
checkboxes.

5 Set the appropriate privileges.

When a box is checked, the privilege is granted. You can change the privileges
for yourself (as the owner), for registered users or groups of users, or for
everyone on the system. For information on specifying registered users or
groups, see “Sharing with Specific Users and Groups,” later in this chapter.

6  Close the Sharing window.

A dialog box appears that allows you to save the changes (by selecting Save),
to close the Sharing dialog box without saving the changes (by selecting Don’t
Save), or to cancel the decision to close the Sharing dialog box (by selecting
Cancel).
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7 To save the changes, select Save.

The folder icon changes to the shared folder icon:

Sharing with specific users and groups

You can name specific users (who are then called registered users) and create
groups of registered users to whom you can grant specific privileges. You can
grant special privileges to a user or group in the User/Group field of the
Sharing dialog box (see “Access Privileges,” earlier in this chapter).

Naming specific users

Follow these steps to register users:

1 Select Control Panels in the Apple () menu and open the Users & Groups control panel.

The Users & Groups window appears.

2 Choose New User from the File menu.

An icon appears, with the label New User.

3 Change the name to that of the new user.

This is the name the user will type when connecting to your shared disk.
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4 Double-click the new user’s icon.

A window appears.

5 Assign a password by typing it into the User Password text box.

Be sure to tell the user what password you typed. Allow the user to connect to
your shared disk by leaving the “Allow user to connect” checkbox checked.
Allow the user to change his or her own password by leaving the “Allow user
to change password” checkbox checked.

6 Close the window; then click Save in the dialog box that appears.

Note:  Use the icon labeled Guest to permit or deny access to guest users who
have no password. This option may be disabled for your system. See your
system administrator.

Naming specific groups

You can create a group of users (called a registered group) as follows:

1 Open the Users & Groups control panel; then select New Group in the File menu.

An icon appears.

2 Change the name of the new group icon to the name you want to assign to the new
group.
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3 Assign users to a group by dragging their icons to the group icon.

4 Close the Control Panel.

Checking group membership

To display the names of the members of the group, do this:

m Double-click the group icon to open it.

To display a list of all the groups to which a user belongs, do this:

m Double-click the user’s icon.

The Groups box lists the user’s memberships.
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Turning guest access on and off

You can turn off access to your folders for guests who have no password.
Follow these steps:

1 Open the Users & Groups control panel (as described earlier in this section).

2 If the “Allow guests to connect” checkbox is checked, click it to remove the X.

3 Click the close box.

Follow these steps to turn on guest access:

1 Open the Users & Groups control panel (as described earlier in this section).

2 If the “Allow guests to connect” checkbox is not checked, click it to add the X.

3 Click the close box.

Program linking

Many applications support program linking, which allows programs to
communicate and exchange information. You can decide whether you want to
permit other users to link to your applications and whom to permit.

For more detailed information, see the Macintosh Networking Reference
published by Apple Computer (part number 030-3936-A).

Check your application’s documentation to be sure that it supports program
linking and to learn how it implements program linking.

Linking to a program

To link to a program, follow these steps:

1 Within your program, display the menu that allows you to link programs.

See the application’s documentation for details. This step normally displays a
dialog box that permits you to choose a computer or server to connect to, a
zone, and a program to link to—much as is done in the Chooser.
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2 Select the zone, the computer or server, and the program; then click OK.

3 Proceed as though you were connecting to a server, as described in “Accessing Another
Computer with AppleShare,” earlier in this chapter.

To disconnect the link, quit from the program.

Allowing others to link to your programs

When you turn program linking on, other users on the network can connect to
your computer to link programs.

Turn program linking on as follows:

1 Open the Sharing Setup control panel window.

See “Making Your MAE Files Available to Others,” earlier in this chapter.

Be sure that you have filled in the boxes in the Network Identity section of the
control panel.

2 Click the Start button in the Program Linking section of the control panel window.

3 Click the close box.
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To control guest access to program linking, follow these steps:

1 Open the Users & Groups control panel (as described earlier in this section).

2 Double-click the Guest icon.

3 If the “Allow guests to link to programs on this Macintosh” checkbox is empty, click it to
permit guest access; to deny guest access, click it to remove the X.

4 Click the close box.

Naming specific users to link to programs

Follow these steps to name specific users who are permitted to link to your
programs:

1 Open the Users & Groups control panel, as described in “Naming Specific Users,” earlier
in this chapter.
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2 If the user is already registered for file sharing, double-click the user’s icon. If not,
choose New User from the File menu and type the name of the user. Then double-click
the icon.

3 Check the box labeled “Allow user to link to programs on this Macintosh” if it is not
already checked.

4 Click the close box.

5 To save your changes, click Save in the dialog box that appears.
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Changing the TCP/IP network interface with MacTCP

MacTCP is a software driver that implements the TCP/IP protocols for the
Mac OS. It allows you to use Macintosh TCP/IP client utilities such as Telnet
or Fetch.

Note:  MacTCP ping does not work correctly on HP-UX and Solaris systems.
Instead, use the UNIX ping command.

In MAE, the MacTCP control panel window has two functions:

m allowing you to view the Internet Protocol (IP) addresses of your TCP/IP
network interfaces

m allowing you to choose which TCP network interface will be used by MAE
if more than one interface is installed

On a Macintosh computer, you can administer TCP/IP features by using the
MacTCP control panel. On MAE, however, the TCP/IP protocols are
implemented through the UNIX interface. You cannot use MacTCP to change
your IP address or change the network interface used by your workstation—
you can only change the network interface used by MAE.

Note:  You cannot use Macintosh programs that allow your workstation to act
as a TCP server.

To choose the TCP/IP network interface that MAE will use, follow these
steps:

1 Choose Control Panels from the Apple () menu and double-click the MacTCP icon to
open it.

The MacTCP control panel window opens, showing an icon for each TCP/IP
network interface. The IP address of the selected interface is displayed in the
bottom portion of the window.
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2 Click the icon for the TCP/IP interface you want MAE to use.

If you have selected a new interface, the following message appears:

Ensure that you have made the correct choice and click OK.

3 Close the MacTCP control panel by clicking the close box.
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8 Managing UNIX Files and Directories in MAE

This chapter describes how to manage UNIX files and X applications on your
MAE desktop. It explains how to perform the following tasks:

m opening UNIX files on the MAE desktop

m adding command options when running a UNIX command

m changing UNIX access permissions

m automatically executing a UNIX command when opening specified files

m using mounted directories as independent volumes

m using UNIX file formats and AppleSingle and AppleDouble file formats
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Opening UNIX files on the MAE desktop

You can use MAE to open UNIX documents, run UNIX commands, and
launch X applications as follows:

m Locate and double-click an icon representing a UNIX file.

A separate X terminal window appears. The contents of the window may vary
in appearance, depending on the nature of the file:

m If you double-click an icon for a UNIX document, the contents of the
document appear in the terminal window in the default text editor.

MAE specifies vi as the default text editor. For information about
changing the default text editor, see “Changing the Default Editor” in
Chapter 9.

m If you double-click an icon for a UNIX command, the results of the
command appear in the terminal window.

If the terminal window is blank, you may need to add options or arguments
to the command. See the next section, “Adding Command Options When
Running a UNIX Command File.”

Note: You cannot run a UNIX command from a Mac OS floppy disk.

m If you double-click an icon for an X application, several application
windows may appear in addition to the terminal window.

If you prefer not to see the terminal window, you can use the X Client
Setup control panel to specify that certain applications open without
terminal windows. See “Customizing X Application Startup” in Chapter 9.

When you are finished with the terminal window, close it.

Note:  If you use the MAE Get Info command to discover features of either a
text file or a binary file, the file is listed as a MAE Helper Document. This file
type supports file launching.

If a MAE filename contains a slash (/) character, the slash is translated to a
colon (:) on the UNIX side because the slash has special meaning in the UNIX
file system. Conversely, a UNIX filename containing a colon (:) will have the
colon replaced by a slash in the MAE filename, because the colon has special
meaning in the Macintosh file system.
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Adding command options when running a UNIX command file

To run a UNIX command, double-click the icon of the UNIX command.

By default, double-clicking an icon for a UNIX command on the MAE
desktop runs the command without letting you specify options or arguments to
the command. However, you can use the launch dialog box to run UNIX
commands with options and arguments.

To run a UNIX command with options and arguments, follow these steps:

1 Press the Control key while double-clicking the UNIX file icon.

The launch dialog box appears. The contents of the box depend on the type of
file you double-clicked.

For example, if you press Control and double-click the cal command icon, a
dialog box like this one appears.

2 Add any appropriate options and arguments to the text box.

Do not include special symbols (such as a tilde ~) or environment variables
(such as $HOME). MAE does not interpret these special symbols in the same
manner as a UNIX environment.

For example, to display the calendar for May 1994, your dialog box might
look like this one.

3 Click Launch.

MAE runs the command and displays the results in a window on your screen.

Note:  The X Client button opens a dialog box that allows you to add the
command to the list in the control panel, if it isn’t already in the list. See
“Customizing X Application Startup” in Chapter 9.
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Setting UNIX permissions

UNIX allows you to set file-access permissions and directory-access
permissions.

File-access permissions

File-access permissions determine who (that is, which user accounts) can use a
particular file and what they can do with it. You can set permissions for each
file that you own. Three types of permissions exist:

m Read permission: You can open the file and read it.

m Write permission: You can change the file.

m Execute permission: You can run an executable file, such as an application
or a script.

Directory-access permissions

The same three kinds of permission exist for directory access as for file access
(described above), but read, write, and execute have different meanings when
they refer to a directory.

m Read permission: You can list the contents of the directory, but you cannot
go into the directory to add, rename, or remove items unless you also have
write and execute permissions.

m Write permission: You can add, remove, or rename the items in the
directory if you already know their names, but you cannot go into the
directory nor list its contents unless you also have read and execute
permissions.

m Execute permission: You can go into the directory, but you can neither
list, add, remove, nor rename its contents unless you also have read and
write permissions. You can access items in the directory only if you know
their names.

Note: If you change permissions on an AppleDouble file format from the
UNIX side, the Finder will not recognize the permission changes unless you
change the permissions on both the file and the resource file (%file).
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Categories of users

Every file’s permissions grant or deny access according to the user’s access
class; that is, his or her membership in three categories. A description of these
three categories follows:

m Owner (sometimes called user) permission applies to the user name that
owns the file. Owner permissions apply only to the user logged in as the
owner of the file. The owner of a file or folder is the user who created it or
to whom ownership has been granted.

m Group permission applies to a specifically named group of users. A file’s
group permissions apply only to those who are assigned to
this group.

m Others (sometimes called world) permission applies to all other users. If
the file has others permission, everyone logged in has those permissions.

MAE provides a menu item that lets you set access permissions for your
UNIX files and folders. To set the permissions for a particular file or folder:

1 Select a file or folder by clicking its icon once.

2 Choose UNIX Permissions from the File menu.

A UNIX permissions dialog box appears. The dialog box illustrated here is for
a folder.
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3 Make any changes you want in the dialog box and then close the dialog box.

An alert box appears, asking you whether you want to save your changes.

4 Click the Save button to save your changes.

To close the dialog box without saving your changes, click Don’t Save. You
can also click the Cancel button, which will leave the dialog box open without
saving your changes.

Note: When you display the UNIX Permissions dialog box for a folder, a
button labeled “Show Mac view” appears at the bottom of the dialog box. If
you click this button, the dialog box displays the folder permissions in
Macintosh terminology rather than UNIX terminology. In Macintosh
terminology, “See Folders and Files” is equivalent to UNIX “read”
permissions, and “Make Changes” is equivalent to UNIX “write” permissions.
To return to the UNIX view of file permissions, click the “Show UNIX view”
button.

See also “Differences Between UNIX and Macintosh Access Permissions” in
Chapter 7.
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Launching commands

You can launch a UNIX command by the drag-and-drop method as follows,
with or without adding options. To launch without adding options, follow
these steps:

m Drag the icon of a file or directory to the icon of the UNIX command.

The UNIX command will execute with the file or directory as its argument.
For example, if you drag the icon of a directory to the ls icon, a new X
window displays a listing of the files in that directory.

To use options, follow these steps:

m Hold down the Control key while dragging the file or directory to the UNIX executable’s
icon.

The launch dialog box appears. Follow the directions in “Adding Command
Options When Running a UNIX Command File,” earlier in this chapter.

Automating command execution for specified files

You can specify that opening any file (or any member of a group of files) will
automatically launch a specified UNIX command and that the file (or group of
files) will be the argument of the command.

1 Choose Control Panels from the Apple menu and open the MAE File Launching control
panel.
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2 Click Add.

A dialog box appears. To return to the control panel without typing a pattern or
command, click Cancel in the dialog box.

3 In the Filename Pattern box, type a filename pattern that identifies a file or group of files.
Then press Tab.

You can include wildcard characters, such as an asterisk (*), where
appropriate. For example, to identify all files ending with .tar.Z you would
type *.tar.Z in the Filename Pattern box.

IMPORTANT  Keep the following in mind when using the MAE File Launching
window.

m If the specified filename is not preceded by *, you must type its full
pathname. If you type the filename alone, without the wildcard or without
its full path, the system will be unable to find the file.

m If the filename contains spaces (as is the case with many Macintosh files),
enclose the full pathname in quotes or precede each blank space with a
backslash. This causes the system to view the space as an ordinary
character.

4 In the UNIX Command box, type the command you want MAE to launch when you open
files specified in the Filename Pattern box.

To pass a filename to the command, include the substitution symbol $1 as a
place holder for the filename. You can also include command options, pipes,
subshells, and shell variables.

For example, to decompress and extract the image of any file ending in
.tar.Z automatically when you double-click the file’s icon on the MAE
desktop, you would type zcat $1 | tar xfv - in the UNIX Command
box.
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5 Click Add or press Return.

The pattern and command you entered appear in the control panel window.

When you double-click an icon to open a file, MAE searches the list of
filename patterns from the top down to determine the command to use.
Because a file can match more than one filename pattern in the list, the order
of the patterns in the list is IMPORTANT. You can change the order of the items
by dragging an item to a different location in the list.

Modifying a pattern or a command in the list

To change a filename pattern or UNIX command in the list, follow these steps:

1 Choose Control Panels from the Apple menu and open the MAE File Launching control
panel.

2 Click the item in the list that you want to change.
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3 Click Modify.

A dialog box appears.

4 Enter new information in the boxes, then click Modify.

The changed item appears in the control panel window.

Deleting a pattern and command from the list

To remove a filename pattern and UNIX command from the list, follow these
steps:

1 Choose Control Panels from the Apple menu and open the MAE File Launching control
panel.

2 In the list, click the item that you want to remove.

3 Click Delete.

An alert box appears.

4 Click the OK button to remove the item.

If you want to leave the item in the list, click Cancel.
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Using mounted UNIX directories as independent volumes

In the Mac OS, all volumes, such as local hard disks, hard disk partitions,
CD-ROM discs, and floppy disks, including volumes mounted over a network,
are represented by icons on the desktop. In UNIX, additional file systems are
mounted as directories somewhere below the root directory. MAE
accommodates both behaviors by representing mounted UNIX file systems as
Mac OS–style multiple independent volumes (MIVs). A Macintosh alias to a
Macintosh volume is used at the UNIX file system mount point.

Note:  You can pick any UNIX directory that you want to represent as the root
of a MAE independent volume (a MIV) by modifying the file .MIV_file.
For more information, see the section “MAE Independent Volumes” in
Chapter 2 of the MAE Administrator’s Manual.

If you use MAE to look at a folder in which a UNIX file system is mounted,
you will notice that the mount point is represented by a Mac OS–style alias to
a volume icon as shown in the following figure.

When you double-click an icon to open the directory, you see the directory
window open, as you would expect, but you also see an icon appear on the
desktop to represent the directory as an independent volume. You can then use
the independent volume as you would any Mac OS volume until you unmount
the directory by dragging its icon to the trash.

Note: An alias representing an independent volume is considered to be
locked; that is, you cannot change its name or move it from its folder until the
directory is unmounted.

For more information about using MIVs, see Chapter 2, “Customizing MAE
and Your Workstation,” in the MAE Administrator’s Manual .
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AppleSingle and AppleDouble file formats

Files in the Macintosh hierarchical file system (HFS) can consist of two parts:
a data fork and a resource fork. The data fork typically contains just text or
data. The optional resource fork typically contains file attributes such as
Finder information (document type, creator application, icon, and so forth),
formatting information, and message strings. Other file systems usually don’t
support such attributes, and therefore usually don’t recognize resource forks.
To preserve all attributes supported by the Macintosh hierarchical file system
(HFS) on such systems, Apple supports two file formats: AppleSingle and
AppleDouble format. MAE can read and write both formats.

Note: This difference in file systems is the reason that MAE and UNIX often
report different sizes for the same file.

By default, MAE stores files (except text files) in AppleSingle format.
AppleSingle format provides a structure for storing all contents and attributes
of a file in a single file. This structure minimizes the potential for file
corruption (in particular, the loss of the resource fork information) when the
file is stored by a foreign file system.

AppleDouble format preserves the separation of the data and resource forks by
storing each in its own file. The two files share the same name except that the
name of the resource fork begins with a % sign. For example, a file named
file1 would appear as file1, the data fork file, and %file1, the resource
fork file.

Macintosh applications are likely to have a resource fork. Document files
often don’t have a resource fork; those that do have one often use it to store
only icons and formatting information. For such files it is sometimes possible
to use the information in the data fork by itself. MAE takes advantage of this
fact by storing text files in AppleDouble format. Mac OS applications can use
both forks of the files as they normally would, and UNIX applications can use
just the data fork file and ignore the resource fork file.

Generally, the use of the two file formats is transparent. For example, if you
copy UNIX files between two copies of MAE, each MAE handles the files
appropriately. However, if you were to copy UNIX files to a Macintosh
computer, those files would be given a resource fork. Then those same files,
subsequently copied to MAE, would be treated as Macintosh files in
AppleSingle format and likely be unusable by UNIX.
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If you encounter problems with a particular application being unable to open
any files, use the AppleDouble control panel to specify that the application
should save documents in AppleDouble format. Alternatively, you can use the
utility asdtool (installed in the apple/bin directory by default) to convert
between the two formats.

You can instruct MAE to save files as AppleDouble by default by adding the
-filedouble option to the MAE command line. This forces MAE to keep
Mac OS files as separate data and resource forks. From MAE, it appears as
one file, but within UNIX, you see a file ‘name’ (data fork) and ‘%name’
(resource fork). The file ‘name’ is the same size in UNIX as the Finder
reports.

Using FTP utilities such as Fetch from MAE can also be problematic. When
“getting” a file, Fetch passes the file to MAE to be written to disk. This works
fine for Macintosh files since they are written as AppleSingle files. However,
when “getting” a UNIX file, MAE will likewise write this file as an
AppleSingle file, which can make it unusable by UNIX applications.
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9 Customizing Your MAE Environment

This chapter explains how to customize the way MAE operates. It includes the
following:

m using control panels

m specifying startup items

m resizing the MAE window

m changing the default editor

m changing keyboard mapping

m customizing X application startup

m moving items into and out of your System Folder

See also Appendix A of this manual for a summary of basic Macintosh skills,
and Appendix B of this manual for features that are new in Version 3.0
of MAE.
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Using control panel features specific to MAE

This section explains how to use the control panels that are specific to MAE. It
also includes control panels that work differently in MAE than on a Mac OS
computer. For general instructions on using control panels, and for
information on control panels that are standard with System 7.5.3, see
Appendix A.

Using the MAE General control panel

The MAE General control panel allows you to perform the following tasks:

m Specify how often the Finder checks for changes to the file system (using
the Finder Window Update section)

m Create a temporary installer volume (see Chapter 3 of this manual)

m Control color flashing when moving between MAE and other X windows
(using the Mac OS Colors section)

m Show hidden UNIX dot files when viewing a folder’s contents by name.

m Set the minimum file size for the fast-delete feature

mmmm Reduce MAE’s use of system resources when MAE has been idle for a
specified period of time (using the Processor Slow Down section)

To use the MAE General control panel, choose Control Panels from the Apple
() menu; then double-click the MAE General icon in the Control Panels
window.
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Finder window update

The Finder window update determines how often the Finder checks for new
files that were created outside MAE. For example, if you created a text file in
your home directory (using a utility such as vi), and your home directory was
open in MAE, you wouldn’t see that file until the next Finder update occurred.
If you do not need frequent Finder window updates, you can improve
performance by setting this number to a high value (such as 120 seconds) and
turning off Finder window update when the Finder is not the active (that is, the
frontmost) Macintosh application. See Chapter 7 of the MAE Administrator’s
Manual.

Displaying UNIX “dot” files on the desktop

Files whose names begin with a dot (.) are displayed if you have checked the
“Show hidden UNIX ‘dot’ files” checkbox. If you don’t want to display these
files, remove the check from the checkbox.

Mac OS colors (reducing color flash)

The term “color flash” refers to a display of unexpected colors and a screen
flash that occurs when you move the pointer among applications with different
color tables. (A color table is an indexed lookup table used to display colors
on a computer screen.) Color flash occurs when the hardware cannot support
the number of colors that must be displayed concurrently. This sometimes
happens when you run an X application that uses its own color table.

The Mac OS Colors section allows you to trade off exactly matching the
colors used by the Mac OS against reducing the amount of color flash you
might experience.

When you choose the “Exact (more color flash)” option, the default colors
used by MAE are the same as those on a Macintosh. You should choose this
option when you use color-intensive applications that work best when MAE is
using the Macintosh colors.

When you choose the “Approximate (less color flash)” option, MAE attempts
to keep the color definitions of its own color table in synchronization with the
default color table, a color table that is shared by many standard X clients.
This approach minimizes any color flash you might experience. This option is
the default, and you should choose it unless you use applications that require
exact Mac OS colors.

Note:  Changes to the Mac OS Colors section do not take effect until you
restart MAE.

For details, see “Color Flash,” in Chapter 3 of the MAE Administrator’s
Manual.
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Installing with the temporary installer volume (TIV)

A temporary installer volume (TIV) is a virtual hard disk—a file on the UNIX
file system that acts within MAE like a Macintosh hard disk.

To use this section of the MAE control panel, follow these steps:

1 Type a number of megabytes in the Size box. Use a size sufficient to accommodate the
application you are installing (at least 10 MB).

If you’re not sure about the amount of disk space your application needs,
consult its documentation.

2 Click the Mount button.

The TIV icon appears on your desktop.

3 Double-click the TIV icon to open the TIV window.

4 Install the application according to its documentation.

IMPORTANT  When you’re asked to choose a destination, be sure to specify TIV
(or the name of the TIV, if you have changed it).

Note: If your TIV is too small to accommodate the installation, drag it to the
Trash and create a new TIV with sufficient space.

5 Drag the newly installed files from the TIV to your home directory.

6 If you are able to use the newly installed application from your home directory, drag the
TIV to the Trash.

If you are not able to use the application, see your system administrator for
help.

Setting the minimum file size used for the Fast Delete feature

When you drag a file to the Trash from a file system other than the one
containing your home directory, MAE copies the file to the Trash and deletes
it from its original location. Depending on the size of the file, this copy
operation can take a significant amount of time. You can eliminate this time-
consuming operation by using a feature called Fast Delete.

The Fast Delete feature allows you to set a minimum file size. When the file
you’re throwing away is larger, MAE offers you the option of deleting the file
immediately, without copying it to the Trash. You cannot retrieve the file once
it has been deleted.
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To set the Fast Delete size, do this:

mmmm Type a new minimum file size in the Fast Delete Size box next to the Trash icon on the
right side of the control panel window.

Slowing MAE’s use of the processor

In order to prevent MAE from using the workstation’s processor unnecessarily
when MAE is not in use, the Processor Slow Down setting instructs MAE to
look for inactivity. After the specified number of seconds of inactivity have
elapsed, MAE slows the processor. The default is 120 seconds.

Note: If processor slow down is on, iconifying the MAE window is an
additional way to tell MAE to slow its use of the processor.

If you wish to change the default, type the number of seconds you want to
elapse. To turn off the Processor Slow Down feature, click the “Processor
Slow Down enabled” checkbox to remove the X.

Setting the date and time

You can use the Date & Time control panel in MAE to view the date and time
and to change the way they are displayed within MAE. You use UNIX date
and time controls to modify the date and time.

Using MacTCP

You can view your TCP/IP network settings in the MacTCP control panel
window, but you can change only the TCP/IP network interface to be used by
MAE. You operate TCP/IP settings through UNIX commands. See Chapter 7
of this manual for more information on MacTCP.

MAE File Launching

For information about using this control panel, see “Automating Command
Execution for Specified Files” in Chapter 8 of this manual.
Changing the way the contents of a window appear

You can change the way the contents of Finder windows are displayed. You
make these changes in the Views control panel.

Use the Views control panel to change the font and font size used in the
Finder.
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Adjusting the amount of memory

The Memory control panel allows you to adjust the amount of memory
available to MAE.

Note: This control panel affects only the MAE memory. You cannot use it to
control memory features of the rest of your system.

Adjusting the memory size of MAE

You may want to increase the amount of memory allotted to MAE if, for
example, you want to run a number of applications simultaneously. MAE can
be set to use up to a maximum of 70 percent of the physical memory on your
UNIX workstation.

To adjust the memory size of MAE, follow these steps:

1 Choose Control Panels from the Apple () menu and open the Memory control panel.

2 To adjust the memory size, click the up or down arrow in the Macintosh Application
Environment Size section.

The amount of memory allocated to MAE is preset to 16 MB.

To reset the memory size to 16 MB, click the Use Defaults button.

3 Choose Restart from the Special menu.

After you restart MAE, you can choose About This Macintosh from the
Apple () menu to see the new amount of memory available to MAE.
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X Client Setup

For information about using this control panel, see “Customizing X
Application Startup,” later in this chapter.

Using the Network control panel

If more than one network interface exists on the workstation, MAE will select
a default interface when it is launched. To switch between two or more
network interfaces on your MAE workstation, select the interface you want in
the Network control panel. For details, see “Changing the AppleTalk Network
Interface” and “Changing the TCP/IP Network Interface With MacTCP,” in
Chapter 7 of this manual.

Specifying items to open at startup

To have a file open automatically when you start MAE, drag the file’s icon or
its alias to the Startup Items folder, which is inside the System Folder in your
home directory. Any programs or documents (or their aliases) that you put in
the Startup Items folder are opened when you start MAE.

If you no longer want a file to open automatically when you start MAE,
remove the file’s icon or alias from the Startup Items folder.

Resizing the MAE window

When you start MAE, its window appears on your screen. By default, MAE
sets the window size to 640 x 480 pixels, which is equivalent to a Macintosh
14-inch screen. You can resize the window in one of three ways:

m by using the standard window controls (determined by your workstation
environment)

m by using the Monitors control panel

m by specifying the -pixelscale option with the mae command

Note: When you resize the MAE window, MAE adjusts the placement of
icons to maintain their alignment along the right edge of the desktop. To avoid
the movement of icons you have placed on the desktop, you may want to
minimize the MAE window instead of using window controls to resize the
MAE window to save screen space.
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Using window controls to resize the MAE window

To resize the MAE window by using window controls, do this:

m Use your window manager to resize the X window that contains MAE.

The appearance and position of the control depends on your workstation. See
the documentation that came with your workstation.

Note: Certain window resizing tools might not scale to the exact size you
specify. This is because the MAE window resizes to a multiple of 32. If you
use window zoom features, the MAE window may not unzoom to the previous
size. The best way to resize a window is from the Monitors control panel.

Using the Monitors control panel to resize the MAE window

The Monitors control panel lets you choose from several standard window
sizes for MAE. To resize the window to a custom size, use standard X window
manager controls as described in the previous section, “Using Window
Controls to Resize the MAE Window.”

To resize the MAE window by using the Monitors control panel, follow these
steps:

1 Choose Control Panels from the Apple () menu and open the Monitors control panel.

2 Click the Options button.
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3 Select the screen size you want and click OK.

The new size takes effect immediately.

4 Close the Monitors control panel by clicking the close box.

Magnifying the MAE window

To magnify the MAE window when you start MAE, you can use the
-pixelscale option with the mae command. This option doubles the size of
the MAE window in both the vertical and horizontal axes. You can use the
-nocursorscale option with the -pixelscale option to retain the original
size of the mouse pointer. See Appendix C for more information.

Note: Using this option to resize the MAE window can significantly increase
the shared memory requirements.

Changing the default terminal

When you launch a UNIX command or open an X application, MAE displays
a terminal window. You can specify a different default terminal or add
command options to the current default terminal using the X Client Setup
control panel.

The type of terminal window is determined by the workstation on which you
are running MAE. The default terminals are

Workstation Terminal window

Hewlett-Packard hpterm

Sun cmdtool

WARNING  Do not change the default terminal unless you are an
experienced UNIX user. The use of quoting, subshells, and sleep is
critical and risky. Consult with your system administrator for more
information.
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To change the default terminal, follow these steps:

1 Choose Control Panels from the Apple () menu and open the X Client Setup control
panel.

2 Select the text in the Default Terminal box.

You can select the text by pressing the Tab key or by dragging across the text.

3 Type a command that will launch the new default terminal.

You can include any options you want. The changes take effect after you close
the control panel.
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Changing the default editor

MAE provides a default text editor that opens when you double-click the icon
for a UNIX text file or document. You can change the default editor by using
the X Client Setup control panel.

To change the default editor, follow these steps:

1 Choose Control Panels from the Apple () menu and open the X Client Setup control
panel.

2 Select the text in the Default Editor box.

You can select the text by pressing the Tab key or by dragging across the text.

3 Type a command to open a UNIX text editor.

You must use $1 as a substitution symbol for the filename.

For example, if you wanted the default editor to be Emacs, you would type
emacs $1 in the Default Editor text box.

IMPORTANT  If the editor’s filename contains spaces, enclose the full pathname
in quotes or precede each blank space with a backslash.

The settings take effect after you close the control panel and remain in effect
until you change them.
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Changing the keyboard mapping

Keyboard mapping determines the relationship between the keys on your
keyboard and their functions in MAE. A keymap tells MAE what character to
produce when you press a key on your keyboard. MAE provides a number of
keymaps that follow Macintosh conventions for entering characters.

Pressing a key usually generates the character marked on that key. However,
to generate certain characters, you may have to press multiple keys in
sequence. For example, to generate the character “é”, you first press Option-E.
Because nothing is displayed at this time, the Option-E combination is known
as a “dead-key” combination. Then you press E again and the entire “é”
character is displayed. The Mac OS uses dead-key sequences to generate many
non-US characters. On some non-US keyboard layouts, dead-key
combinations are assigned to a key on the workstation keyboard that would
normally generate a character. You can use the Key Caps application in the
Apple () menu to determine the combination of keys that generates a
particular character.

You cannot edit the MAE keymaps, but you can change the modifier keys. See
“Reassigning Modifier Keys,” later in this section.

When you start MAE, it tries to determine the type of keyboard you have and
then selects the keymap most appropriate for that keyboard. If you change
keyboards at your workstation or display MAE on a remote workstation that
has a different keyboard, you should verify that a new keymap that
corresponds to the new keyboard has been selected. See “Choosing a New
Keymap,” later in this section, for instructions.

IMPORTANT  The keymaps supplied by MAE assume certain default keyboard
mappings on the workstation on which you display MAE. If you change the
keyboard mapping of the X display server on that workstation while MAE is
running, unexpected behavior may result in MAE when you press a key on the
keyboard. In the MAE Keyboard control panel, select the Generic keymap and
then the previously selected keymap to restore the MAE keyboard mapping.
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Choosing a new keymap

MAE provides keymaps for a variety of keyboards, including foreign-
language keyboards. To choose a new keymap, follow these steps:

1 Choose Control Panels from the Apple () menu and open the MAE Keyboard control
panel.

IMPORTANT  Make sure you open the MAE Keyboard control panel, not the
Keyboard control panel.

2 Choose a keymap from the Keymap pop-up menu.

Choose a keymap that corresponds to your keyboard. If there is no selection
that corresponds to your keyboard, select generic layout and set the modifier
keys as desired for your keyboard. The setting in the Keyboard control panel
determines the generic menu title.

3 Close the control panel.

The new setting takes effect immediately.
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Choosing a keyboard layout for a different language

If your keyboard uses a language not supported in the MAE Keyboard control
panel list, you can choose an appropriate keyboard layout, as follows:

1 Choose Control Panels from the Apple menu and open the Keyboard control panel.

2 Choose a keyboard layout from the Keyboard Layout menu.

Choose a keyboard layout that corresponds to your keyboard.

3 Close the control panel.

The new setting takes effect immediately.

4 Open the MAE Keyboard control panel and verify that generic layout is selected.

Change the modifier keys as desired.



Chapter 9 /  Customizing Your MAE Environment 139

Reassigning modifier keys

MAE maps Macintosh modifier keys and X Window System modifier keys to
keys on your keyboard. The MAE Keyboard control panel displays the
mappings.

To help you determine the keys on your keyboard that correspond to the
names in the Keyboard Key column of the control panel, the following table
lists the aliases of some commonly used modifier key equivalents for Sun and
Hewlett-Packard standard keyboards.

Note:  The table lists only a few of the possible keyboards that you can use.

Equivalent modifier Key name as it appears
Keyboard Physical key key in MAE in the control panel

Sun Control Control Control Left

Alt Alt Alt Left

key left of the Space bar Command (x) Meta Left

key right of the Space bar Option Meta Right

Hewlett- Ctrl Control Control Left
Packard

Print/Action Option Execute

Extend Char Command (x) Meta Left
(left of the Space bar)

Extend Char Alt Meta Right
(right of the Space bar)
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To reassign individual modifier keys, follow these steps:

1 Choose Control Panels from the Apple () menu and open the MAE Keyboard control
panel.

2 In the left column, click the button for the MAE modifier key whose mapping you want to
change.

A message similar to the following appears.

3 Press the key on the keyboard that you want to map to the MAE modifier.

For example, to assign the Command modifier key function to the key labeled
“Alt” on your keyboard, click the Command button in the left column of the
control panel and then press the Alt key on your keyboard.

If you don’t want to change the mapping, press Cancel.

If you press a key that is already mapped to another MAE modifier, a message
appears.

Click the OK button in the dialog box if you want to assign the new modifier
function to the key. Click Cancel if you want to leave the key assigned to the
old modifier function.
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The message disappears and the name of the key you’ve pressed appears in the
right column in the control panel. The name of the pop-up menu changes to
Custom followed by the name of the previous layout to indicate that the
modifier keys have been changed.

After you change modifiers, but before you close the control panel, you can
reset the modifiers to their previous settings by clicking Revert in the control
panel. You can undo any single change with the Undo command in the Edit
menu.

4 Close the control panel.

Your modifier key settings take effect. You can restore the original settings by
choosing the original keyboard from the pop-up menu.
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Customizing X application startup

When you open a UNIX file on the MAE desktop, a terminal window appears.
(See “Opening UNIX Files on the MAE Desktop,” in Chapter 8 of this
manual, for more information.) If you prefer, you can customize MAE so that
it doesn’t display a terminal window in situations where an X application
opens its own windows. You use the X Client Setup control panel to specify
applications that should open without displaying a terminal window.

To specify X applications to open without a terminal window, follow these
steps:

1 Choose Control Panels from the Apple () menu and open the X Client Setup control
panel.

2 Click Add to specify a new application.

A dialog box appears.
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3 In the Directory/File box, type the pathname of the application.

For example, to specify that the xcalc application should open without a
terminal window, you would type /directory-path/xcalc in the box, where
directory-path is the pathname of the directory in which xcalc is located.

IMPORTANT  Keep the following in mind when using the X Client Setup
window.

m Use the full pathname of the file or the directory.

m If the X client’s filename contains spaces, enclose the full pathname in
quotes or precede each space with a backslash.

You can specify an entire directory of applications that should open without
terminal windows. (Any subdirectory within this directory will not be
affected.) To do so, you would type /directory-path in the Directory/File text
box, replacing directory-path with the full pathname of the appropriate
directory. This specifies that an application located in /directory-path will not
display a terminal window when you open the application on the MAE
desktop.

4 Click Add to put the new pathname in the X Client Applications list.

Modifying the pathname for an X application

To change the name or the pathname of an X application that appears in the X
Client Applications list in the X Client Setup control panel, follow these steps:

1 Choose Control Panels from the Apple () menu and open the X Client Setup control
panel.
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2 In the control panel, select the pathname or the name that you want to modify.

3 Click Modify.

A dialog box appears.

4 Type your changes in the Directory/File box.

5 Click Modify, or press Return.

The revised pathname appears in the X Client Applications list in the control
panel.



Chapter 9 /  Customizing Your MAE Environment 145

Deleting the pathname for an X application
To remove a pathname from the X Client Applications list in the X Client
Setup control panel, follow these steps:

1 Choose Control Panels from the Apple () menu and open the X Client Setup control
panel.

2 In the control panel, select the application you want to remove.
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3 Click Delete.

A message appears.

4 Click OK to delete the pathname.

To leave the item unchanged, click Cancel.

Installing files in your System Folder

You can customize your MAE environment by installing programs and files in
the System Folder in your home directory. You install the following types of
files in your System Folder by dragging their icons onto the System Folder
icon (not into the open System Folder window) in your home directory:

m system extensions and control panels (also called INITs and cdevs)

m preference files for application programs

m fonts

These files are stored in specific folders inside your System Folder. When you
drag a file’s icon to the System Folder icon, the Finder recognizes which type
of file it is and stores it in the appropriate folder. If you drag one of these files
to the open System Folder window, the file is not stored in the appropriate
folder automatically.

Sometimes these files are installed by means of an installer program that
comes with the files. Check the instructions that came with the files for any
specific installation procedures.

IMPORTANT  MAE supports many, but not all, of the system extensions that run
with the Mac OS. In particular, you should not replace any of the System
Folder components included with MAE. If you want to use other extensions,
control panels, and so forth, try adding them one at a time. If one causes any
problems, you can then start MAE with the -noextensions option and
remove the software causing the problem.
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Other items that you want to put in the System Folder need to be dragged to a
specific folder. Such items include the following:

m items you want to have appear in the Apple () menu

m applications or scripts you want to have run when MAE starts

m applications or scripts you want to have run just before MAE shuts down

Installing an item in the Apple () menu

To have a program, document, or other item appear in the Apple menu, drag
the item’s icon or its alias to the Apple Menu Items folder, which is in the
System Folder in your home directory.

Note:  If the Apple () menu does not contain the items it should, make sure
that the Apple Menu Items folder is in the System Folder in your home
directory, and that you have read permissions for the Apple Menu Item folder.
See “Setting UNIX Permissions” in Chapter 8 of this manual.

Remove an item from the Apple () menu by opening the Apple Menu Items
folder and dragging the item’s icon (or its alias) out of the folder.

Removing files from your System Folder

You remove a file from your System Folder by dragging its icon out of the
System Folder in your home directory. To activate the change, restart MAE.

In general, you can remove Apple menu items that you don’t need. For
example, you may not need the Calculator or Puzzle control panels.

It is advisable to keep backup copies of the files.

IMPORTANT  MAE relies on the presence of several modified Macintosh
extensions and control panels. These extensions are different from those of the
Mac OS system releases and MAE installs them differently to minimize disk
space usage. These extensions should not be replaced, modified, or upgraded
except by the MAE installer. If these files are corrupted, they can be recreated
by removing the System Folder and restarting MAE.



148 Macintosh Application Environment User’s Manual



149

Appendix A Summary of Basic Macintosh Skills

This Appendix provides information about working on the MAE desktop for
those who are unaccustomed to using the Macintosh. It tells you how to
perform the following tasks:

m using control panels to customize MAE

m working with floppy disks

m creating aliases

m searching for files

m installing fonts

For more extensive information about basic features of the Macintosh, see the
online MAE Guide or the Macintosh User’s Manual.

See also Chapter 9 for ways of customizing MAE and Appendix B for features
that are new or changed in version 3.0 of MAE.
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Using control panels

This section explains how to use the System 7.5 control panels that come with
MAE. For descriptions of control panels that are specific to MAE or that work
differently in MAE and the Mac OS, see Chapters 8 and 9 of this manual.
Control panels that are enhancements not normally included with System 7.5
are described in Appendix B of this manual.

To open a control panel, follow these steps:

1 Choose Control Panels from the Apple () menu.

The Control Panels window appears.

2 Double-click the icon of the control panel that you want to open.

Alternatively, if you have submenus turned on in the Apple Menu Options
control panel, you can use the submenu to open the control panel directly.
Open the Apple () menu and drag to the Control Panels item, still holding
the mouse button down. A submenu listing all of the active control panels
appears. Drag to the right, until the mouse pointer is in the submenu, then drag
to the control panel that you want and release the mouse button.

The following sections contain information about some of the more frequently
used control panels.

Selecting colors

The Color control panel lets you change the highlight color (the color of
selected text on the desktop) as well as the color of the window borders.
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Changing the highlight color

1 In the Color control panel, choose a color (or Other) from the “Highlight color” pop-up
menu.

The color appears in the “Sample text” box.

If you choose Other, the color wheel dialog box appears. Drag the scroll box
up or down to change the brightness of the color wheel. Then click a color on
the color wheel to select it.

The new color is displayed in the upper half of the color square if your
monitor is set to display 16 or more colors or shades of gray.

The current color remains in the lower half of the square for comparison; you
can click there to go back to it.

2 When you have selected the color you want, click OK.

The new color appears in the “Sample text” box. The change takes effect
immediately.

Changing the color of windows

m In the Color control panel, choose a new color from the “Window color” pop-up menu.

The change takes effect immediately.

Customizing the desktop with General Controls

You can customize the appearance of the desktop within the MAE window by
adjusting the blinking of menu items and the insertion point. To change the
desktop pattern, use the Desktop Patterns control panel, described later in this
Appendix.

IMPORTANT  The settings you specify in the General Controls panel affect only
the environment inside the MAE window. To change aspects of your X
environment, you use standard X commands.
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Adjusting the blinking of menu items and the insertion point

You can adjust the number of times a menu item blinks when it’s chosen and
the blinking rate of the insertion point.

m In the General Controls panel, click the button for the number of times you want menu
items to blink when they are chosen. (Or click the Off button to prevent menu items from
blinking.)

To adjust the blinking of the insertion point, do this:

m Click the button for the blinking rate you want.

The insertion point in the control panel shows the rate of blinking you
selected.

Note:  To change the date and time, see Chapter 9.

Selecting a keyboard layout

You use the Keyboard control panel to select different keyboard layouts for
different languages, adjust the rate at which a character repeats when its key is
held down, and adjust the delay before the character begins repeating.

Note:  When MAE starts, it tries to determine the type of keyboard you have.
Based on that determination, it selects a keyboard layout (also called a
keymap). If an appropriate keyboard layout is not available, it selects the U.S
layout. You should not change the keyboard layout unless your language is not
supported in the MAE Keyboard control panel. Choosing the wrong layout can
make it very difficult to work in MAE.

To select a different keyboard layout, do this:

m Scroll through the Keyboard Layout list until you see name of the layout (keymap) you
want; then click that layout.

To adjust the rate at which a key repeats when it is held down, do this:

m Click the button for the rate you want (or click Off if you don’t want keys to repeat).
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To adjust the delay before keys repeat, do this:

m Click the button for the delay you want.

If the keys repeat when you don’t want them to, set a longer delay before a
character begins repeating.

For more information about keyboards, see “Changing the Keyboard
Mapping” in Chapter 9. That section explains how the keys on your physical
keyboard are mapped to specific functions within MAE.

Using the Labels control panel

The Labels control panel allows you to change the labels (and colors, if
your monitor displays colors or shades of gray) that are available in the
Label menu.

To change a label, do this:

m Drag across the label name to select it; then type your new label.

To change the color of a label, follow these steps:

1 Click the color (in the control panel) that you want to change.

The color wheel dialog box appears.

2 In the color wheel dialog box, click a color on the color wheel.

The new color is displayed in the upper half of the color square. The current
color remains in the lower half of the square for comparison.

3 When you have selected the color you want, click OK.

The labels and colors you choose remain in effect until you change them.
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Changing monitor characteristics

If your monitor displays colors or shades of gray, you can use the Monitors
control panel to designate the number of colors or shades of gray that you
want displayed on the MAE desktop.

1 Choose Control Panels in the Apple () menu; then choose Monitors.

2 Select Grays or Colors.

3 Choose the number of shades desired (or Black & White).

The new color choice takes effect immediately.

4 Close the control panel.

The Monitors control panel also allows you to change the size of the MAE
window. See “Resizing the MAE Window,” in Chapter 9 of this manual.
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Adjusting mouse preferences

You can use the Mouse control panel to adjust two aspects of how your mouse
(or other input device, such as a trackball) operates:

m tracking (the relation between the movement of the mouse on your desk and
the movement of the pointer on the screen)

m double-clicking speed

IMPORTANT  Changing the tracking speed in the Mouse control panel changes
the tracking speed for your X server as well, but the changes may be lost the
next time you restart your X server. For instructions on permanently setting
the mouse tracking speed for your X server, see the documentation that came
with your X server.

To change the double-clicking speed, do this:

m Click the speed you want.

The double-clicking speed affects only the MAE window.

To change the tracking speed, do this:

m Click the speed you want.

If you click Fast, the pointer moves more than twice as fast as you move the
mouse. The Very Slow option is useful for drawing with a mouse or a graphics
tablet.

Your choice remains in effect until you choose a different tracking option or
restart your X server.

You can use the X command xset to fine-tune mouse action. With the xset
command, you can get the mouse pointer to move more smoothly by setting
the mouse acceleration anywhere from 15 to 20 (by default, the acceleration
is 4). See the xset man page for more information about the command.
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Selecting number displays

You can use the Numbers control panel to choose from several different
formats for displaying numbers and currency.

Selecting extensions

Use the Extensions Manager control panel to specify which extensions are on
or off when the computer starts up. You can establish sets of related
extensions and switch them on or off as necessary.

Click a checked item in the list of extensions to turn it off. (Items with
checkmarks are on.) Shift-click to turn off two or more checked items.

If you want to turn all extensions off or on, choose All Off or All On from the
Sets pop-up menu.

To undo changes you’ve made, click Undo.
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To create a set of extensions, follow these steps:

1 Turn on the extensions you want to include.

2 Open the Sets pop-up menu and choose Save Set.

3 Type a name for the extension set and click OK.

To remove a set of extensions, follow these steps:

1 Open the Sets pop-up menu and choose Delete Set.

2 Click the name of the set you want to delete from the list; then click Delete.

Note: You can’t delete certain sets of extensions.

Your changes take effect the next time the computer starts up.

Selecting sound

You can use the Sound control panel to change your sound volume, alert
sound, and playback device.

Adjust the use of sound in MAE as follows:

m Choose Control Panels in the Apple () menu and open the Sound control panel.
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Adjusting the alert sound

To change the alert sound and adjust its volume, follow these steps:

1 Click the desired alert sound in the list on the right.

The sound plays when you click it.

2 Adjust the volume by dragging the slider on the left.

3 Open the Alert Sounds pop-up menu for other choices.

The menu offers the options Sound Out and Volumes. The Sound Out option
allows you to set the audio output resolution to whatever the hardware allows.
The Volumes option adjusts the volume of your system’s sound.

Note: The Sound In option is not currently supported by MAE.

Setting the audio output resolution

Choose Sound Out in the Sound control panel’s pop-up menu to display the
following dialog box:

Choose a sampling rate in the Rate pop-up menu.

Changing the sampling rate affects the performance and the sound quality. See
Chapter 6 in the MAE Administration Manual.
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Adjusting the sound volume

To adjust the volume of sounds produced by your applications, do the
following:

1 Choose Volumes in the Sound control panel’s pop-up menu.

A dialog box with a slider appears. This dialog box sets the system volume on
your workstation.

2 Drag the slider to select the appropriate volume.

3 Click the close box.

Issues and concerns with setting up sound

Although sound on MAE acts much as it does on the Macintosh, there are
some setup issues that you should be aware of, especially concerning software
patches for specific workstations. These are discussed in Chapter 6 of the MAE
Administrator’s Manual. Consult the Read Me file (README.TXT) for
information on software patches.
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Choosing a desktop pattern

The Desktop Patterns control panel now provides a wider array of colorful and
interestingly textured desktop patterns.

You can now add your own designs by copying and pasting graphics or photos
(stored as PICT files) into the control panel. These new images become a new
desktop pattern.

To choose a desktop pattern, follow these steps:

1 Use the scroll bar at the bottom of the control panel to display the patterns.

2 When you find a pattern you want to use, click Set Desktop Pattern.

To add a pattern of your own, follow these steps:

1 Create the image you want with a graphics program, a scanner, or another source of
images.

2 Select the image and copy it by choosing Copy from the Edit menu.

3 Click the open Desktop Patterns window to make it active; then paste the pattern in by
choosing Paste in the Edit menu.
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Launching programs easily

You can add buttons to a window that appears in the Launcher control panel
that allow you to launch frequently used programs with one click.

Add items to the Launcher as follows:

1 Open the Launcher Items folder (in the System Folder).

2 With the Launcher Items window open, choose New Folder from the File menu to create a
new folder for the application you want to add to the Launcher.

3 Press Option-8 to place a bullet (m) as the first letter of the new folder’s name, then
rename the new folder with the name of the application or group of applications.

4 Place aliases for the relevant applications into the folder.

5 Close the Launcher Items window.

6 Choose Control Panels in the Apple () menu and open the Launcher control panel.

To open one of the applications, follow these steps:

1 Click the button with the name of the folder you want.

2 Click the button for the application you want.
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Creating Sticky Notes

You can create notes that will remain on your screen by selecting Stickies in
the Apple () menu. Select New Note in the File menu to create a note.

Sticky Notes are windows, but they have no scroll bars. To scroll through a
sticky, use the Up and Down Arrow keys.

Saving screen space with WindowShade

The WindowShade control panel allows you to customize the command used
to reduce screen clutter by shrinking windows. With two or three clicks on the
title bar of the window you shrink windows so that only their title bars show.

1 Choose Control Panels in the Apple () menu and open the WindowShade control panel.

The WindowShade control panel allows you to set the number of clicks it
takes to roll up the window and leave only the title bar showing.

2 Click 2 or 3 to turn WindowShade on and to have a window roll up by either double-
clicking or triple-clicking the window’s title bar.

Click Off to turn WindowShade off.

3 Click the checkbox next to one of the modifier key buttons if you want to add a modifier
key to the command.

4 Click the “Make sounds when using WindowShade” checkbox to have your computer
produce a “zip” sound when you use WindowShade.

You click the title bar again to expand the window to full size.
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Finding a file or a folder

When the Macintosh Finder is the active program, you can use the Find
command in the File menu to find a file or folder on any disk whose icon is on
the desktop.

You can locate items by opening the Apple () menu and choosing Find File
or by choosing Find from the File menu.

Note: You should not use the Find command to locate items on remote
volumes. It searches the entire volume, and searching large volumes,
especially those with multiple mount points, can take a long time, causing the
search to appear to have frozen.

1 Use the pop-up menu labeled “Find items” to specify where you want to search.

You can search on all disks connected to your computer, on shared disks
(servers) only, on all disks except shared disks (local disks), or on an
individual disk. When you search for items, you can specify criteria for the
computer to use in the search.

2 Click the More Choices or the Fewer Choices button until the number of rows is the same
as the number of search criteria you want to use.

You can specify as many as 10 criteria in the search window.
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3 Starting with the leftmost pop-up menu, describe the items you want to find.

As appropriate, type text to search for, or click a number and then use the Up
or Down Arrow to change it.

If you need to add more search criteria, use the pop-up menus to identify the
new criteria. (If necessary, expand the window by clicking the More Choices
button to add criteria.)

4 Click Find when you have completed your search criteria.

Only the items that meet all criteria are displayed in the search results window.
If no matching items are found, you hear a beep or see a message.

5 Click an item in the list to see its location.

The location of the item selected is displayed in the bottom section of the
search results window.

You can double-click the item to open it.

You can also choose commands from the File, Edit, and View menus to work
with the items located in the search.

Note: You can’t use the Find command to locate items inside the System file
(which is inside the System Folder). You need to open the System file to see
its contents.

If you’re using the Launcher, the Find command locates items or aliases for
items inside the Launcher Items folder.

Getting information about your files

When the MAE Finder is the active program, you can obtain information
about your files and directories with the Get Info command. To use the
command:

1 Select an item.

2 Choose Get Info from the File menu.

The Info window appears.
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The Info window provides information about the item such as size, kind,
location, and modification dates. You can also use this window to lock a file
(so it can’t be changed), turn a document into a stationery pad, change the
amount of memory a program uses, and change a file’s icon.

Note:  The Info window for MAE differs slightly from that of the standard
Mac OS. In the Mac OS, when you get information for a folder, it shows the
number of files contained; however, it does not count invisible files. In MAE,
the Info window includes invisible files in the total file count for a directory.

Working with floppy disks

This section tells you how to copy files to and from floppy disks and how to
lock a disk.

Copying files to a floppy disk

To copy a file to a floppy disk, follow these steps:

1 Insert and mount a floppy disk formatted for the Macintosh file system.

See “Mounting Floppy Disks and CD-ROM Discs With the Toolbar” in
Chapter 6 of this manual.

2 Drag the icons of the files or folders that you want to copy to the floppy disk icon on the
MAE desktop. Release the mouse button when the disk icon is highlighted.

The original files remain where they were.

Copying files from a floppy disk

To copy a file from a floppy disk to your system, follow these steps:

1 Insert and mount the floppy disk containing the Macintosh files you want to copy to your
system.

See “Mounting Floppy Disks and CD-ROM Discs With the Toolbar” in
Chapter 6 of this manual.

2 Double-click the disk icon to display a window that shows the contents of the disk.

3 Select the icons of the files or folders that you want to copy and drag them to the folder
on the hard disk where you want to store them.
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If you have problems copying files to a floppy disk

If you can’t save files on a floppy disk, there are several possible causes: the
disk may be damaged or locked, the disk may be too full to store more
information, or the disk drive may not be working properly. To help identify
the problem, follow these steps:

m Make sure you’re using a high-density (1.4 MB) floppy disk formatted for
the Mac OS.

m Make sure that the tab on the back of the disk is in the unlocked position
(that is, make sure that the square hole is closed). If a disk is locked, its
window on the MAE desktop shows a “locked” icon in the upper-left
corner.

m If a message reports that the disk is full, either throw away unnecessary
files on the disk or unmount and eject that disk; then insert and mount
another disk that has adequate space.

m Check the disk for obvious damage to the plastic case or the sliding
metal shutter.

m Insert a different disk and try saving again. If you can’t save your files on
the second disk, the problem may be with the disk drive.

Locking a floppy disk

You can protect the contents of a floppy disk by locking it. When a floppy
disk is locked, you can examine its contents but cannot initialize the disk or
change any of the information on it. To lock a floppy disk, use your thumb or
a push-pin to slide the tab on the back of the disk so that the square hole is
open. To unlock the disk, slide the tab back so that it covers the square hole.
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Creating an alias

An alias serves as a substitute for a file, a folder, a disk, or another item that
the alias represents. You can make as many aliases for an item as you want.

Note:  When you drag an item from a Finder window to the MAE desktop,
MAE automatically creates an alias for the item, instead of moving the item to
the desktop. To create a copy of the file rather than an alias, hold down the
Option key while dragging the icon.

To create an alias, follow these steps:

1 Click to select the item for which you want to make an alias.

2 Choose Make Alias from the File menu.

The alias appears on top of the original. Its name is in italics and ends with
“alias.” The name is selected for editing.

3 If you wish, change the name of the alias; then move it to wherever you want it to reside.

Note: If you try to open an alias and nothing happens, or if a message reports
that the original file isn’t available, then the alias may be damaged, the
original may have been deleted, or the original may have been moved or
renamed from outside the Macintosh environment (in other words, in the
UNIX environment). Throw away the alias and create a new one.

If you create an alias to a path that is also a UNIX mount point, when you
open the alias, MAE mounts the MIV (if is not already mounted).

Locating the original of an alias

To locate the original item to which an alias points, follow these steps:

1 Select the icon of the alias whose original you want to find.

2 Choose Get Info from the File menu.

The Info window for the alias opens.

3 Click the Find Original button in the Info window.

The window containing the original item opens, and the item’s icon is
highlighted.

If you deleted the original, a message will report that the original can’t be
found. Aliases are not deleted when the original files are deleted.

If you move the original of an alias to a different file system, you break the
link between the alias and the original.
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Using fonts

MAE provides a number of fonts; moreover, you can install additional
Macintosh-compatible fonts.

IMPORTANT  MAE does not support X Window System fonts.

MAE uses two types of fonts: outline and bitmapped. With an outline font
(also called a TrueType, scalable, or variable-size font), you can print or
display typefaces of different sizes from a single font file.

In the case of a bitmapped font, you must have a separate font file for each
size of typeface.

Both types of fonts are installed in the Fonts folder in your System Folder.

Note: Check with your system administrator before installing fonts. Fonts can
be installed in such a way as to make a single copy of the font available to all
MAE users on a workstation, yielding significant disk space savings.

Installing fonts

To install fonts in your System Folder, follow these steps:

1 Quit all open applications in MAE.

2 Locate the icon of the font that you want to install and drag it to the System Folder icon
(not the open System Folder window) in your home directory folder.

A message asks if you want to install the font in the appropriate folder.

3 Click OK in the dialog box.

Removing fonts

To remove fonts from your System Folder, follow these steps:

1 Quit all open applications in MAE.

2 Open the System Folder in your home directory folder.

3 Locate the Fonts folder and open it.

4 Locate the icon of the font that you want to remove. Drag it out of the Fonts window and
out of the System Folder window. (Shift-click to select more than one icon.)

Some fonts are in suitcases. Open the suitcase to see the individual font files.

5 Close the Fonts window and the System Folder window.
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Appendix B New Features in MAE Version 3.0

MAE version 3.0 contains many new features that considerably expand its
usefulness. Some of the new features are from the Mac OS 7.5 and some are
specifically developed for MAE. This chapter describes

m support for Mac OS System 7.5.3

m features unique to MAE 3.0

See also Chapter 9 of this manual for ways of customizing MAE and
Appendix A for a summary of basic Macintosh skills.
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New System 7.5 features

MAE 3.0 incorporates the improvements of the Mac OS System 7.5.3. This
section describes the new features for MAE derived from this release of the
Mac OS. The features include

m PC Exchange

m Macintosh Easy Open

m Macintosh drag-and-drop capability

m Script Editor and AppleScript

m CloseView

m Scriptable Finder and automated tasks

m Enhanced Apple Guide

m Control Strip

PC Exchange: compatibility with DOS and Windows files

MAE can open disks and files that are formatted for IBM-compatible personal
computers. You can exchange disks and documents with DOS and Windows
computers. You can also use MAE to initialize disks for DOS and Windows
computers.

Floppy disks formatted for IBM-compatible personal computers have
this icon:

You can open the DOS disk just as you would open a Macintosh disk and open
files on the disk just as you open Macintosh files. MAE uses “translators” and
your application programs to open documents created in DOS applications.

To assign a Macintosh program to open each type of DOS file, open the Apple
() menu and choose Control Panels. Then open the PC Exchange control
panel.

Note: An application’s icon must appear in the Finder before it can be
associated with a DOS file type.
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Macintosh Easy Open: improved file opening

With Macintosh Easy Open, you can open most Macintosh, DOS, and
Windows files even if you don’t have the program that created the document.
MAE uses “translators” (not manufactured by Apple) and your programs to
open documents created with programs you do not have.

To set Easy Open options, open the Apple () menu and choose Control
Panels. Then open the Macintosh Easy Open Setup control panel.

Macintosh drag-and-drop capability

You can move text, graphics, sounds, and QuickTime movies without using
the Copy and Paste commands. With programs that support the Macintosh
drag-and-drop feature, you can drag an item within a document or between
two open documents.

You can also drag an item from a document onto the desktop to create a
“clipping.” A clipping is a file that can be dragged into another document
later. For example, you may save your business address as a clipping and drop
it into letters and other documents.

To use the drag-and-drop feature, select the item, then drag it to a new
location. You can practice using this feature with the Note Pad, SimpleText,
Scrapbook, and Stickies.
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Script Editor and AppleScript

The ability to automate tasks built into the Mac OS is now available in MAE.
You can use the Script Editor application program to automate tasks in the
Finder and in application programs that support AppleScript.

Using the Script Editor

The Script Editor is a program that lets you write scripts that automate a series
of actions. Using the Script Editor’s “Watch Me” feature, you can create a
script by recording actions.

To create your own scripts, use the Script Editor located in the AppleScript
folder (inside the Apple Extras folder) on your hard disk. For instructions, see
the user’s guide located in the AppleScript folder.

Magnifying the screen image with CloseView

The CloseView control panel lets you magnify the image on your Macintosh
screen up to 16 times.

To use CloseView, open the control panel. Use this control panel to turn on
magnification, invert the screen image, and customize CloseView.

When CloseView is on and magnification is off, a rectangle on the screen
indicates which area will be magnified. You can move the rectangle by
moving the pointer.

Note: Some keyboard shortcuts might not work with CloseView, depending
on your type of keyboard. Use the control panel instead.
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The Scriptable Finder and Automated Tasks

MAE includes sample scripts that automate Finder tasks, such as raising and
lowering the speaker volume. You can find the sample scripts in the Apple
Extras folder on your hard disk.

To try out one of the scripts, open the Apple () menu and choose Automated
Tasks.

Apple Guide for SimpleText

SimpleText is a word processor that supports new Macintosh features such as
Macintosh drag-and-drop capability, fonts, and text styling. SimpleText also
opens TeachText documents. You can open several SimpleText documents at
once. You can also play QuickTime movies.

Now MAE includes the SimpleText Guide, providing help for using
SimpleText.

Control Strip

You can use the Control Strip to specify a variety of settings from your
desktop. In MAE, the Control Strip is in the bottom left corner, just above the
MAE Toolbar.

The Control Strip contains icons that let you turn on or off AppleTalk, set up
and monitor file sharing, set your display, specify your monitor resolution, and
change your speaker volume.

To close the Control Strip, click the tab at the right end.
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MAE 3.0 Enhancements

The following sections describe the new features for MAE 3.0, including

m Enhanced installer

m Floating licenses

m Additional CD-ROM formats

m Support for multiple TCP/IP interfaces

m Improved Find File utility

m Improved performance for remote X display servers

m X Window pixel scaling

m Independent volume support

m Symbolic links as Mac OS aliases

m Smaller System Folders

m AppleDouble control panel

m More concurrently open files

m Improved keyboard support

m Improved file-sharing security

m Native floating-point optimizations

m Software FPU integration

Enhanced installer

The MAE installer provides several options to improve the installation process
when it is run from the command line and provides an automatic system
reboot after kernel modules are installed. See Appendix C for details.

Floating licenses

MAE uses the popular UNIX-based FLEXlm license manager software to
simplify the use of MAE in a networked environment by allowing users to
share licensed copies of MAE more efficiently. See the MAE Administrator’s
Manual for details.

Support for additional CD-ROM formats

MAE supports the use of CD-ROM discs in the standard ISO 9660 format as
well as the single-session Photo CD format. See Chapter 6 for information on
setting up and using CD-ROM drives.
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Support for multiple LAN interfaces

MAE provides support for multiple LAN interface cards in your workstation
and allows you to specify which one MAE will use for MacTCP services. See
Chapter 9 for details.

Improved Find File utility

The new version of Find File is faster and allows you to differentiate between
AppleShare and NFS servers in your searches.

Improved performance for remote X display servers

Improvements in client/server communications greatly improve the
performance of MAE when it is displayed by a remote X server. See Chapters
1 and 2 for installation and startup instructions.

X Window pixel scaling option

This command-line option allows you to easily magnify your MAE window at
startup to twice the standard size for easier viewing.

Independent volume support

All UNIX mount points are automatically represented as Macintosh volumes.
You can also specify UNIX directories that you want mounted on the MAE
desktop much like Macintosh volumes.

Symbolic links as Mac OS aliases

All UNIX symbolic links are automatically represented as Macintosh aliases.

Smaller System Folders

A distributed approach to system resources reduces the disk space required by
additional System Folders on a workstation.

AppleDouble control panel

The AppleDouble control panel allows you to specify applications that should
use the AppleDouble format for file operations, preserving the separation of
the resource and data forks of Macintosh files and allowing you a greater
flexibility in using non-Macintosh files.
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More simultaneously open files

MAE now allows up to 1024 files to be open simultaneously.

Improved keyboard support

MAE provides easy-to-recognize keyboard maps and automatically determines
which one to use. You can also use the standard Mac OS Keyboard control
panel to change keyboard maps.

Improved file-sharing security

MAE increases the administrator’s options to restrict the user’s ability to share
files and folders.

Native floating-point optimizations

One of the components of the Macintosh Toolbox is the Standard Apple
Numeric Environment (SANE), which provides a uniform mechanism for
applications to perform floating-point computations. Most Macintosh
applications that require floating-point computation use the SANE mechanism.
(Some applications use their own custom floating-point software instead.)
SANE provides several fixed and floating-point data types, but the default for
most SANE operations is the 80-bit extended precision real data type.

MAE attempts to use native floating-point instructions on the host RISC
processor to implement the most frequently used SANE operations. This
approach can result in a performance improvement of up to 300 percent for
applications that use SANE extensively, but it has no benefit for applications
that use their own custom floating-point software.

Because no RISC processor supports the 80-bit extended-precision real data
type, to implement native floating point, MAE must convert to and from the
64-bit double-precision real data type present on all RISC processors. This
conversion occasionally results in a very small loss of precision beyond the
fifteenth decimal place. It is rare that any application will depend on this
degree of precision, but for some sophisticated scientific or mathematical
applications there may be a variation in behavior. The -sane MAE
command-line option can be used to disable the use of native floating-point
operations for those applications that depend on extended precision.
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Software FPU integration

Some Macintosh applications require the use of floating-point instructions
based on the Motorola 6888x FPU in order to run. On Macintosh computers
that don’t have the capability to execute these instructions, the shareware
Software FPU Control Panel can be used to emulate the behavior of a floating-
point unit, allowing most applications that use floating-point instructions to
run normally.

MAE now includes Software FPU MAE 3.0, a licensed version of Software
FPU, as a standard part of the System Folder; no shareware fee is required.
The interaction between Software FPU MAE 3.0 and MAE has been
optimized for approximately 50 percent better performance than with the
shareware Macintosh version.

The Software FPU MAE 3.0 Control Panel is disabled by default. To enable it,
open the control panel and click the On button.

Note: The Software FPU MAE 3.0 Control Panel will not function properly
on any Macintosh system other than MAE 3.0.
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Appendix C Command Options and X Resources

This appendix lists the command options and the X resources that can be used
to configure MAE at startup. For more information on the command options,
see the mae manual page.

For more information on X resources and their uses, see Chapter 2 of
the MAE Administrator’s Manual.
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Command options

The following table describes the options available for MAE.

Command option Description

-appledir directorypath Specify the location of the apple
directory. The default is the directory in 
which the MAE package was installed.

-applepath directorypath Sets the MAE environment variable 
APPLEPATH to specify a directory to 
be searched for application 
information when the Desktop 
database is rebuilt. Similar to the UNIX 
$PATH variable, this variable is a number 
of colon-separated pathnames.

-display display Specify the X display server on which 
you want MAE to appear. The default 
is specified by the DISPLAY
environment variable.

-filedouble Force MAE to use AppleDouble format 
for files. Creates a separate file for the 
resource fork, indicated by a filename 
starting with %.

-fstimeout seconds Specify the time in seconds that
MAE will wait for a response from 
an NSF-mounted file system.

-geometry width xheight+X+Y Set the size and position of the MAE 
window (excluding the Toolbar) to width
pixels wide by height pixels high
(default is 640 x 480 pixels), with the top 
left corner at X pixels to the right and Y
pixels down from the upper-left corner of 
the screen.

-help Display all the MAE command options.

-iconic Start MAE minimized (as an icon). The 
default is for MAE to start up in an open 
window.

-installcmap Specify that MAE should force the 
installation of its X colormap.
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Command option Description

-macdir directorypath Specify the location of the .mac
directory. The default is the user’s home
directory. If the -sysfol option is used, the
default of -macdir changes from the user’s
home directory to the location specified by
-sysfol. The .mac directory needs to be at the 
root of a MIV (/MIV/.mac).

-maxdepth bitdepth Specify the maximum frame-buffer 
bit depth. The default is dynamically set 
to the maximum supported by the X 
server. Valid bitdepth values are 1, 2, 4, 
8, 16, and 24. (Note:  This option 
specifies the maximum depth MAE can 
use; it does not mean that MAE will use 
this depth.)

-memory memorysize Specify the memory size for applications 
within MAE (in MB). The default is 16 MB.

-noextensions Disable Macintosh system extensions 
(has the same effect as holding down 
the Shift key while booting a
Macintosh computer).

-nocursorscale Defeats scaling of the mouse pointer if 
specified with the -pixelscale option.

-nosound Disable MAE sound support.

-pixelscale Magnify display by doubling the number of pixels in 
both the X and Y axes.

-rebuild Rebuild the desktop when MAE is 
started.

-sane Prevent MAE from using native RISC
floating-point instructions. Provides
greater compatibility with SANE at the
expense of runtime performance.

-sysfol system-folder Specify the directory system-folder
to use as the System Folder. The
default is $HOME/System\ Folder. If you 
specify -sysfol but not -macdir,
MAE looks in the same location of your 
system folder for your .mac directory.

-title string Specify the title to appear in the MAE 
window’s title bar. The default is 
Macintosh Application Environment [version].

-version Print the MAE version information.

-zappram Specify that the virtual PRAM be reset 
when MAE is started.
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X resources

X resources have been defined for several of the mae command arguments as
follows:

-appledir

X resource Mae.appleDirectory

Description Pathname of apple directory to use

Example Mae.appleDirectory: /u/benjamin/apple

-filedouble

X resource Mae.fileDouble

Description Cause MAE to use AppleDouble file format

Example Mae.fileDouble: True

-fstimeout

X resource Mae.fsTimeout

Description Set the time MAE waits for a response from an NFS-mounted file system

Example Mae.fsTimeout: 15

Default 10 seconds

-geometry

X resource Mae.geometry

Description Geometry string of the following form:
<width>x<height>{±}<xoffset>{±} <yoffset>

Example Mae.geometry: 640x480+0+0

-iconic

X resource Mae.iconic

Description Starts MAE up in an iconified state

Example Mae.iconic: True
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-installcmap

X resource Mae.installColormap

Description Forces MAE to install its own colormap

Example Mae.installColormap: True

-macdir

X resource Mae.macDirectory

Description Pathname of the .mac directory to use

Example Mae.macDirectory: /u/benjamin/mac.dir

-maxdepth

X resource Mae.maximumDepth

Description Maximum bit depth for MAE

Example Mae.maximumDepth: 8

-nosound

X resource Mae.noSound

Description Disable sound support

Example Mae.noSound: True

-nocursorscale

X resource Mae.noCursorScale

Description If pixelscale is specified, do not scale cursor

Example Mae.noCursorScale

-pixelscale

X resource Mae.pixelScale

Description Magnify display by two in X and Y axes

Example Mae.pixelScale: True
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-title

X resource Mae.title

Description String to use as title of MAE window

Example Mae.title: MAE-1

-sysfol

X resource Mae.systemFolder

Description Pathname of System Folder to use

Example Mae.systemFolder: /u/benjamin/System Folder

Note: X resources are not available for the applepath, help, memory,
noextensions, rebuild, sane, version, or zappram options.
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Index

A
access privileges  98
Acrobat Reader  19
aliases  21

creating  167
locating the original file  167

AppleDouble control panel  175
AppleDouble format  122
AppleGuide  173
Apple () menu,

installing items in  147
appleping command  41, 93
AppleShare  95–104

accessing disks and folders  95–104
making folders available  97–104
setting a password  98

AppleSingle format  122
apple/sys directory  21
AppleTalk,

AppleTalk commands  93
overview  92
printing  57

appletalk command  41
-D option  93
-s option  93

AppleTalk zones,
choosing  94
definition  56, 92

application installation,
transferring files from another computer  52

applications,
installing  48
installing using a MIV  49
opening  54
quitting  54

asdtool command  41
atlookup command  41, 93
Audio Server  19
automated tasks  173

B
balloon help  15

starting  15
stopping  15

C
capturing screen images  71
cd command  24
cdevs  146
CD-ROM discs,

configuring for  76–78, 79
mounting  23, 81
unmounting  82

CD-ROM formats  12
Chooser,

description  56, 92
for selecting AppleTalk printers  57
for selecting UNIX printers  58

CloseView control panel  172
colon ,

character in filenames  112
color flashing (reducing)  127
colors, changing  150
colors on monitor  154
color table  127
Command-Option-Escape key sequence  54
command options,

mae command  40, 180
commands,

appleping  93
appletalk  93
atlookup  93
cd(1)  24
Find  163
lp  56
lpr  56
mae  38, 40
mount  85
ps  85
tar  85
umount  82
xhost  43
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Command Tool window (Solaris)  22, 23
Common Desktop Environment  19
configuring for CD-ROM discs  76–78, 79
configuring for SCSI floppy disks  76–78, 79
control panels  129

AppleDouble  175
Color  150
Control Strip  173
Date & Time  129
Desktop Patterns  160
Extensions Manager  156
General Controls  151
general information  150
Keyboard  152
Labels  153
Launcher  161
MacTCP  108, 129
MAE File Launching  117
MAE General  126
MAE Keyboard  137
Memory  130
Monitor  132
Monitors  154
Mouse  155
Network  94
Numbers  156
Sound  157
Users & Groups  101, 106
WindowShade  162
X Client Setup  113, 135, 142

Control Strip  173
copying from MAE applications to X

applications  72
copying from X applications to MAE

applications  72
Custom installation of MAE 20

procedure  28–30

D
Date & Time control panel  129
default editor,

changing  135
default MAE directory  27
default terminal,

changing  133
Desktop Patterns control panel  160
disk space  18
displaying UNIX dot files  127
documentation  14
dot files,

displaying on the MAE desktop  127

E
Easy installation of MAE  20

procedure  26–28
editor,

changing default  135
default  112

execute permission  114
Extensions Manager control panel  156

F
fast delete feature  128
features,

new in MAE version  3 12
new in MAE version 3.0  169

Fetch utility  123
file formats

AppleSingle and AppleDouble  122
file names,

special characters  112
file opening  171
file-sharing,

guest permission  104
file-sharing access privileges  98–104

compared with UNIX permissions  99
setting privileges  100–101
specifying groups  102
specifying users  101

file-sharing groups,
checking membership  103

Find command  163
Finder window update (in MAE General control

panel)  127
Find File utility  12
finding files  163
FLEXlm License Manager  19
floating license  12
floating-point optimizations  176
floppy disks,

copying from 800K to 1.4 MB disks  83
copying to and from  165
formatting for Macintosh  82
locking  166
mounting  81
unmounting  82
using from PCs  170

fonts  168
bitmapped  168
installing  168
outline 168
removing  168

fonts (MAE)  168
formatting floppy disks for Macintosh  82
FPU integration  177
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G
Get Toolbar Help option,

in Toolbar pop-up menu  73
group permission  115
groups,

specifying for file sharing  102
guest access  104

H
help,

MAE Guide  16
toolbar   73

Hide Toolbar,
in Toolbar pop-up menu  70

Hide Toolbar option,
in Toolbar pop-up menu  74

home directory  44
hpterm window (HP-UX)  22, 23

I, J
independent volume  12
INITs  146
installation options  12
installing AppleTalk,

rebooting  28
installing applications,

adding extensions  48
methods  48
transferring files from another computer  52
using a MIV  49
using a TIV  49

installing MAE  17–36
aliases  21
command options  33–34
Custom  20
Custom (procedure)
Custom install  28
destination directory  27
Easy install  20
Easy (procedure)  26–28
extensions  21
file system problems  36
for HP-UX  19
for Solaris  18
from a remote server  23
from CD-ROM  22–23
getting help  25
installing locally from a remote server  24
options  20
overview  20
packages  30, 33
prerequisites  18
quitting the installation process  25
Remove option  20, 31

troubleshooting  34, 42
upgrade  21

installing the License Manager  31
INSTALL.SH command  24
ISO 9660  12

K
keyboard mapping,

changing  136–141
keyboard operations  13
keymaps  137, 138

L
labels  153
LAN interface  12
Launcher control panel  161
license.dat file  22
license key  22
License Manager,

man pages  41
lp command  56
lpr command  56
LprWriter icon  59

M
.mac directory  39
macdisks.HP-UX file,

editing ,  79
macdisks.Solaris file,

editing  77–78, 79
Macintosh Application Environment CD-ROM  23
Macintosh applications,

installing
opening  54
printing from  64
quitting  54
troubleshooting installation  52

Macintosh drag-and-drop capability  171
Macintosh Easy Open  171
Macintosh files,

printing  65
MacTCP  108

ping command  108
MAE,

directories created during initial startup  39
documentation 14
installing  17–36
new features  12
quitting  42
restarting  52
running remotely  39
Toolbar help  16
upgrading  21
World Wide Web page  16
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Mae.appleDirectory. See X resources
MAE CD-ROM  19
mae command  38, 40

command options  40, 180
MAE desktop, changing  151
MAE File Launching control panel  117
MAE General control panel  126
Mae.geometry. See X resources
MAE Guide  16
MAE hangs,

using Shift-Control-E  73
Mae.iconic. See X resources
MAE independent volume (MIV)  49
MAE information on the Web  16
Mae.installColormap. See X resources
MAE Keyboard control panel  137
Mae.maximumDepth. See X resources
MAE memory  130
Mae.system.folder. See X resources
Mae.title. See X resources
MAE Toolbar  70
MAE Toolbar help  16
MAE window,

resizing  131
manual pages,

setting directory  41
using MAE man pages  41

memory,
recommended  18

MIV. See  MAE independent volume
.MIV_file  121
modifier keys  13

reassigning  139–141
table of keys  139

monitor colors  154
Monitors control panel  132
mount command  85
mouse buttons  13
mouse operation, adjusting  155
mouse operations  13

N
Network control panel  94
network interface, choosing  12
network interfaces,

switching  94
Numbers control panel  156

O
owner permission  115

P, Q
packages for installation  30, 33
Page Setup dialog box   64
password,

Appleshare  98
PC Exchange  170
permissions,

UNIX and FileShare compared  99
UNIX vs. Macintosh  99

Photo CD  12
pointer,

containing  73
PostScript printers  56
PPD file,

downloading from the Internet  60, 63
selecting  60, 62

print command,
changing  61
default  58–61, 63

printer,
selecting  57
setup  58

printing,
AppleTalk  57
canceling a print job  66
from Macintosh applications  64
Macintosh files  65
page setup options  64
selecting an AppleTalk printer with the

Chooser  57
selecting a UNIX printer with the Chooser  58
setting up  56
UNIX commands  58
with default print command  58–61, 63

processor slow down feature  129
program linking  104–107

allowing guest access  106
allowing other to link to your programs  105
linking to a program  104
registering users  106
unlinking from a program  105

ps command  85

R
Read Me file,

on line  15
Read Me file (README.TXT),

in root directory of MAE CD-ROM disc  15, 19
read permission  114
remote operation of MAE  39
Remove installation of MAE,

procedure  31, 32
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removing an old MAE installation  31, 32
repeat rate of characters  152
resizing the MAE window  131
restarting MAE  52

S
screen images,

capturing  71
Script Editor  172
SCSI floppy disks,

configuring for  76–78, 79
SCSI ID number  77
sharing your folders  97
Shell Tool window (Solaris)  22, 23
Shut Down command  42
SimpleText  173
slash (/) character,

in file names  112
SMlock file  45
Software FPU utility  13
Sound control panel  157
special characters,

in filenames  112
starting MAE  38

troubleshooting  42
startup items,

specifying  131
Startup Items folder  131
startup programs  156
Sticky Notes  162
STREAMS/UX  19
superuser privileges,

for installation  23, 24
when needed in installation  22

swap space  44
symbolic links  175
system folder  13, 146, 147

application installation  51
installing files in  146, 147
restoring  52

System 7.5.3 support  12

T
tar command  85
temporary installer volume (TIV)  49–52, 128

creating  49
opening  50
using to install applications  49

terminal, default  133
terminology  13
time zone, setting  45
TIV. See temporary installer volume

Toolbar  70–74
capturing MAE screen images  71
containing the MAE pointer  73
copying from MAE applications to X

applications  72
copying from X applications to MAE

applications  72
displaying pop-up menus  70
displaying Toolbar help  73
help  16
hiding  74
mounting CD-ROM discs and floppy disks  81

Toolbar pop-up menu,
Get Toolbar Help option  73
Hide Toolbar option  70, 74

troubleshooting,
installation  34
installation of Macintosh applications  52
installing MAE  34, 42
mounting CD-ROM discs or floppy disks  85
printing  66
starting MAE  42
Unable to open file apple/lib/engine  42, 46
using Shift-Control-E if MAE hangs  73

troubleshooting (Installer)  36
Cannot create directory [destination-

directory]  34
Installer cannot create specified directory  35
Installer cannot find installation packages  35
Installer could not install some packages  35
Invalid characters in pathname  35
Not enough free space on [destination-

directory]  34
Some packages not removed during

installation  35
Unexpected error  35

TZ environment variable  45

U
UNIX commands,

adding options and arguments in MAE  113
launching automatically for specified files  117
launching with “drag-and-drop”  117
running from floppy  112

UNIX directories,
as independent volumes  121

UNIX files,
opening with MAE  112

UNIX permissions,
categories of users  115
compared with file-sharing privileges  99
setting  114–116

unmount command  82
upgrading MAE  21
users,

specifying for file sharing  101
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V
View control panel  129
volume,

adjusting  159
Volume Manager  18

Extension package  19

W
window,

magnifying  133
window controls  132
windows,

specifying appearance of contents  129
WindowShade control panel  162
World Wide Web page  16
write permission  114

X, Y
X application,

deleting pathnames  145
modifying pathnames  143

X application startup,
customizing  142

X Client Setup control panel  135
xhost command  43

X resources  182
for command-line arguments  182
Mae.appleDirectory  182, 183
Mae.geometry  182
Mae.iconic  182
Mae.installColormap  183
Mae.maximumDepth  183
Mae.systemFolder  184
Mae.title  184

X Window scaling  12
x windows display server  12

Z
zone,

selecting  57
zones,

AppleTalk  92
AppleTalk (defined)  56


